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The OpenLP User Manual is here to help you learn how to use OpenLP. From installing, to setting up your monitors,
to using OpenLP on a regular basis, all the information you need to know is in here. And if you see some of it is
missing, please help us add it.
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CHAPTER

ONE

DOWNLOAD THIS MANUAL

You can download this manual as a PDF from here: https://manual.openlp.org/OpenLP.pdf

To open the downloaded manual, you’ll need a PDF reader. On macOS and Linux your computer should already have
a PDF reader. On Windows you’ll need to install SumatraPDF.

If you’re reading the downloaded manual, you can get the online version at https://manual.openlp.org
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CHAPTER

TWO

GETTING STARTED WITH OPENLP

2.1 Introduction

2.1.1 About

OpenLP stands for “Open Lyrics Projection” and is presentation software developed for churches to provide a single
easy to use interface for the projection needs of a typical worship service. First created in 2004, it has steadily grown
in features and maturity such that it is now a mainstay in hundreds of churches around the world.

OpenLP has searchable databases of songs and Bible verses allowing them to be projected instantly or saved in a
pre-prepared order of service file. Themes allow for a variety of presentation options and allow you to add attractive
visuals to enhance your presentations. PowerPoint and OpenOffice presentations, videos and audio files can be run
from within the program removing the need to switch between different programs. Alert messages can be displayed
so the nursery or car park stewards can notify the congregation easily. Remote capability allows the worship leader to
change songs, or for alert messages to be sent from anywhere on the network, even via a smart phone or tablet.

Being free, this software can be installed on as many PCs as required, including the home PCs of worship leader(s)
at no additional cost. Compared to the expensive site licenses and restrictions of commercial software we believe
OpenLP is the perfect choice for quality and value. Still in active development by a growing team of enthusiastic
developers, features are being added all the time resulting in continual improvement of the software.

OpenLP is licensed under the GNU Generic Public License, which means that it is free to use, distribute, modify, and
it stays free.

2.1.2 GNU General Public License

The GNU General Public License was specifically chosen because it ensures the above mentioned freedoms. It specif-
ically states that you are not allowed to charge for the software, and that you have to distribute the source code as
well.

You can find a copy of the GNU General Public License from the Help menu selecting about OpenLP or view the
license on-line.
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2.2 Minimum System Requirements

OpenLP should run well on any fairly recent machine that can run a Chromium browser. If you do not find specific
installation instructions for your system, you might still be able to run OpenLP but issues caused by your platform will
not be addressed. The most constraining OpenLP dependency is PyQt5-WebEngine. If it is available for your system,
chances are that you can run OpenLP from `PyPI`_.

The following are suggested specifications to get reasonable performance. It may be possible to run OpenLP on less
powerful hardware but you may not get the performance you desire.

• 2Ghz CPU

• 2GiB RAM

• 100MB free disk space

• Windows 10/11, Linux, macOS (10.8 or later)

• Multiple Monitor Support is highly recommended (not required)

• For Presentation support:

– Windows: PowerPoint XP or later or LibreOffice Impress 4 or later

– Linux: LibreOffice Impress 4 or later

– macOS: Not supported yet due to limitations in Keynote and PowerPoint

• The Generic Document/Presentation and Songs of Fellowship song import options require LibreOffice 4 or later

:: _PyPI: https://pypi.org/project/OpenLP/

2.3 Installing OpenLP on Microsoft Windows

Installing OpenLP is identical over all supported versions of Windows. After downloading the file from the website
open the file by double clicking when the download is complete. After opening the downloaded file agree to open the
unverified file if you are prompted. On Windows 8 you might have to click More info before you can verify by clicking
Run anyway.

Next select your language and click OK

After reading the welcome message click Next to continue the installation.

6 Chapter 2. Getting Started With OpenLP
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Agree to the license agreement. Click Next to continue.

Select the install location for OpenLP. Choosing the default location is generally the best choice. Click Next to

2.3. Installing OpenLP on Microsoft Windows 7
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continue.

Select a start menu folder for OpenLP to be visible in. The default location here is generally the best choice. Click
Next to continue.
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Select if you want to create a desktop or Quick Launch icon. Click Next to continue.

Review your previous choices. If you need to make any changes click the Back button to get to the previous choices,

2.3. Installing OpenLP on Microsoft Windows 9
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or click Install

The progress bar will update you on how far along the installation has gone.
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When the install is complete you will have the option to launch OpenLP.

After making your selection click Finish

2.4 Installing OpenLP on macOS

If you have not already downloaded the correct file from the OpenLP website, download it now. Then double click on
the .dmg file. This will open a window with two icons: An OpenLP icon and an Applications Folder icon.

2.4. Installing OpenLP on macOS 11
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To install OpenLP, simply drag the OpenLP icon over to the Applications folder icon. A window will show the
installation progress.

Since OpenLP is an Open Source project we do not have the financial means to buy an official Apple Developer
certificate, which means that macOS will refuse to open OpenLP because it has not been signed by an official Apple
Developer certificate. We do assure you that if you downloaded OpenLP from the OpenLP website, it is safe to install
and run. To start OpenLP open the Applications folder, find the OpenLP icon and click it. The first time you start
OpenLP a window will open showing the verification progress.

12 Chapter 2. Getting Started With OpenLP
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The verification will fail and show this warning:

Click OK to close the window. You will now have to tell macOS to trust OpenLP despite this. Open the Apple menu
and choose System Preferences. . . . Now click Security & Privacy as marked below.

2.4. Installing OpenLP on macOS 13
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In the default General tab you should now see a window similar to the one below. Click the Open Anyway button to
open OpenLP.
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macOS will now try to open OpenLP again. Again a window will open showing the verification progress.

A window will now open with a warning that OpenLP is unsafe. Click Open to open OpenLP.

2.4. Installing OpenLP on macOS 15
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The first time OpenLP runs you will be prompted about granting some extra rights to OpenLP. OpenLP uses these
rights to control PowerPoint and Keynote presentation programs. Click OK to allow this.
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The first time you start a PowerPoint or Keynote presentation from OpenLP you will also be asked to grant rights to
those applications as can be seen below. Again click OK to allow this.

2.4. Installing OpenLP on macOS 17
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2.5 Installing OpenLP on Linux

Setting up OpenLP varies by distribution. We have included documentation on popular distributions or distributions
that have OpenLP available from their package managers. It should be possible to get OpenLP running on nearly any
Linux distribution.

2.5.1 Ubuntu

Installation of OpenLP on Ubuntu can either be done through the Software Center or the command line. Command
line instructions will be included at the end of this section on Ubuntu and its variants.

OpenLP supports Ubuntu 23.04 or later.
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Ubuntu, Xubuntu

To install OpenLP in Ubuntu, open the Software Center, search for OpenLP and click Install.

You will see the install progress as OpenLP and the dependencies required for it to run are downloaded.

2.5. Installing OpenLP on Linux 19
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After installation you should see that OpenLP is installed.

Kubuntu

Open up Discover, type “openlp” in the search box and press Enter. Next, click on the Install button.

Ubuntu Command Line Install

Open a terminal and type the following command to install OpenLP:

user@ubuntu:~$ sudo apt-get install openlp

OpenLP should now be available in your desktop’s menu system, but if you wish to run OpenLP from the command
line type:

user@ubuntu:~$ openlp

2.5.2 Fedora

To install OpenLP on Fedora follow the instructions below. The instructions describes how to do the install when
using GNOME, KDE or the command line.

Note When installing OpenLP you will need to have administrator privileges. You will be asked for the administrator
password to install.

20 Chapter 2. Getting Started With OpenLP



OpenLP Reference Manual, Release 3.0

Fedora (GNOME)

Installing with Fedora you will use the default Add/Remove Programs available from System → Administration →
Add/Remove Programs in Fedora 14 and below or in Applications → System Tools → Add/Remove Programs

Search for OpenLP in the search box

Check the check box for OpenLP then click Apply

2.5. Installing OpenLP on Linux 21
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Click Continue to confirm installing any additional software.
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You should now see the packages downloading in the lower left corner.
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Click Run to run OpenLP now, or Close to run OpenLP later.

OpenLP will be available in Applications → Sound & Video → OpenLP
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Fedora (KDE)

From the Kickoff open Software Management. Type OpenLP into the search box. Then click Find by name or press
Enter.

Select OpenLP from the search results. Next, click Apply

2.5. Installing OpenLP on Linux 25
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Now give permission to install other software dependencies that are needed by clicking Continue
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Once completed you can run OpenLP by clicking on its logo in the completed install notification, or from the Kickoff
menu.

Fedora Command Line Install

To install OpenLP from the command line type:

user@fedora:~$ sudo yum install openlp

OpenLP should now be available in your desktop’s menu system, but if you wish to run OpenLP from the command
line type:

user@fedora:~$ openlp

2.5. Installing OpenLP on Linux 27
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2.5.3 Linux Mint

The following instructions are for a standard Linux Mint install. These instructions will not work with Linux Mint
Debian Edition. Most users should be able to follow the instructions for Software Manager Install, but if your are
running Linux Mint without the standard desktop please see the Linux Mint Command Line Install install instructions.

Software Manager Install

The administrator password will be required several times during the installation. To install OpenLP open the Software
Manager from the Mint Menu.

Type OpenLP into the search box to locate the OpenLP package.
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Click on OpenLP from the results then click Install.

2.5. Installing OpenLP on Linux 29
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After OpenLP is installed you can close the Software Manager and start OpenLP from the Sound and Video section of
the Mint Menu.

Linux Mint Command Line Install

Open a terminal and type in the following command to install OpenLP:

user@mint:~$ sudo apt-get install openlp

OpenLP should now be available in your desktop’s menu system, but if you wish to run OpenLP from the command
line type:

user@mint:~$ openlp
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2.5.4 openSUSE

OpenLP is available using 1-Click Install on the openSUSE Build Service website. Go to the openSUSE Build Service
site and type openlp into the search box.

Then click 1-Click Install

Select Open with YaST 1-Click Install then click OK

2.5. Installing OpenLP on Linux 31
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Additional repositories may need to be enabled. This will be performed automatically. Accept the default options by
clicking Next

Confirm you want to install OpenLP and click Next
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Before the installation takes place confirm adding the repositories and installing the software again. Click Next to
continue.

Since this is a third party application the software key will have to be accepted. Click Trust to accept the software key.

2.5. Installing OpenLP on Linux 33
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OpenLP will now be installed. When the install process is completed click Finish.

OpenLP will now be available for use.
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2.5.5 Arch Linux

OpenLP is available on Arch Linux through the Arch User Repository, or AUR. Info on the AUR can be found at the
Arch wiki.

There are a variety of tools and methods to install from the AUR. For this example we will demonstrate using Yaourt.
For more info on Yaourt please see the Yaourt documentation.

From a terminal type:

user@arch:~$ yaourt -S openlp

OpenLP should now be available in your desktop’s menu system, but if you wish to run OpenLP from the command
line type:

user@arch:~$ openlp

2.5. Installing OpenLP on Linux 35
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CHAPTER

THREE

REFERENCE MANUAL

3.1 First Time Wizard

When using OpenLP for the first time, the First Time Wizard will help you with setting up your installation. This
wizard is not intended to be a comprehensive setup but will help you with the basics.

3.1.1 Select Translation

You can choose the translation you want to use or let OpenLP automatically select it based on your operating system
locale. Click OK to continue.

The “Welcome to the First Time Wizard” dialog box will appear next. Click Next.
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The wizard will now download information from a server about which bibles, songs and themes that can be downloaded
be the wizard. This can take a few moments, depending on the speed of your internet connection and the load on the
server, so please be patient.
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3.1.2 Activate Required Plugins

OpenLP has several plugins to choose from. By default, all plugins are enabled, except the Remote Access plugin.
For more information on these plugins, please read the Library section in the manual. If you are not sure of which
plugins to enable or disable, leave the selection as is. You can easily activate or deactivate plugins later, when OpenLP
is running, by going to Settings → Plugin List. Click Next to continue.
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3.1.3 Sample Songs

OpenLP provides some sample songs in a few languages for downloading and importing into your new song database.
This is convenient for new users who do not have any songs yet. If you already have songs in your database, OpenLP
will simply add these sample songs to your database, leaving your existing songs intact. Once you are happy with
which songs you’d like, click Next.

3.1. First Time Wizard 41
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3.1.4 Sample Bibles

There are also a number of free Bibles that you can download and install. Using the check box next to each Bible, select
each Bible that you would like installed. If you do not wish to install any Bibles, simply leave them all unchecked.
Once you are happy with your selection, click Next to continue.
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3.1.5 Sample Themes

Some sample themes are also available for download and installation into OpenLP. As with the Bibles, simply check
the check box next to each theme to select it. If you are a new user, these themes can help you understand how themes
work. If you are happy with your selected themes, click Next to continue.
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3.1.6 Default Settings

Default Display Monitor

Screen 2. If you are installing OpenLP but are not connected to a second output at the time, you can set this up later
by going to Settings → Configure OpenLP.
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Default Theme

If you have selected one or more themes on the themes page of the wizard, you can select which theme you’d like to
be the default theme.

If you are happy with the selections you have made, click Next to continue to the next page.

Making progress.
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On the last page of the wizard, OpenLP will download the sample songs, Bibles and themes, and set up OpenLP for
you. Click Finish and OpenLP will start.
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First the OpenLP logo will be shown for a few seconds while the program loads.

Then OpenLP will import the songs that were added by the first time wizard.

3.1. First Time Wizard 47
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The main window.

3.1.7 Re-run First Time Wizard

If you wish to add items from the First Time Wizard at a later date or had an error while installing OpenLP you can
run it again by going to Tools → Re-run First Time Wizard. Select Yes to run the First Time Wizard.

After selecting Yes the First Time Wizard will run again.
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3.2 Menu Items

The following are the menu items that are listed across the top of OpenLP. There is a brief description or link for their
intended purpose.

3.2.1 File

New Service Creates a new service. New, Open and Saving the Service

Open Service Load an existing service. New, Open and Saving the Service

Save Service Saves your existing loaded service.

Save Service As Saves your newly created service.

Recent Services

Displays your last files opened configurable here. Data Location

Clear List Clears your recent files list.

Import This provides the items you can import.

Settings Import your configurable settings from another computer. Learn more about Backing up OpenLP.

Theme Import a theme that has been previously exported. Importing Themes

Song Import your songs previously exported. Song Importer

CCLI SongSelect Import your songs from CCLI SongSelect. Song Importer

Bible Import Bibles from another program, the internet or a previously exported Bible from OpenLP. Bible
Import Wizard

Export Provides the items you can export.

Settings Export your configurable settings to a file to import to another computer. Learn more about Backing
up OpenLP.

Theme Export your theme. Exporting Themes

Song Export your songs. Exporting Songs

Print Service Gives you the ability to print your service. Print Service

Exit Closes OpenLP. If there is an open service that has not been saved you will be prompted to do so.

3.2.2 View

Layout Presets These three settings are optimized for setup and live display.

Show all Displays all of the panels of OpenLP.

Setup Displays Preview, Library and Service.

Live Displays the live panel and Service

Clicking on any of the next items will hide or show its respective panel.
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Library Hide or show Library.

Projector Controller Hide or show Projector Manager.

Service Hide or show Service.

Themes Hide or show Themes.

Preview Hide or show the preview panel.

Live Hide or show the live panel.

Lock visibility of the panels Using this lock will keep all your panel settings the way they are when clicked, whether
hidden or showing. Click this again to unlock the panels.

3.2.3 Tools

Open Data Folder You can access your OpenLP data here. Your Bibles, songs, themes and other items are stored
here.

Note: It is possible to delete a Bible, theme or another resource you need. If anything is deleted in this folder it is not
recoverable through OpenLP.

Re-run First Time Wizard This will bring up the dialog box to run the first time wizard again. First Time
Wizard

Update Theme Images Changing screen resolution can have an affect on theme images. Use this to correct the
images.

Songs

Re-index Songs This rebuilds the internal song indexes to make them work following code correc-
tions. You would generally use this after a software upgrade.
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Find Duplicate Songs Start wizard for detecting and removing duplicate songs.

Songs List Report This creates CSV file with song database.

Song Usage Tracking

Configure your song usage tracking. Song Usage Tracking

Toggle Tracking Provides the means to turn song usage tracking on or off. There will be a visible check mark
if song usage tracking is on.

Extract Tracking Data Brings up a dialog box to extract song usage data.

Delete Tracking Data Brings up a dialog box to delete song usage data.

Alert: Configure an alert. Alert

3.2.4 Settings

Manage Plugins Provides the configurable settings to control your plugin’s. Plugin List

Language: You can choose another UI language here or leave it on Autodetect.

Configure Formatting Tags Provides the configurable settings for formatting tags. Formatting Tags

Configure Shortcuts Provides the configurable settings for shortcuts. Customize Shortcuts

Configure OpenLP Provides the configurable settings for OpenLP. Configuring OpenLP

3.2.5 Help

Online Help This is a direct link to OpenLP’s operating manual.

Web Site This is a direct link to OpenLP’s web site.

About Provides information, credits and license for OpenLP.

3.3 Configuring OpenLP

OpenLP has many options you can configure to suit your needs. Most options are self-explanatory and we will quickly
review them.

To configure OpenLP, click on Settings → Configure OpenLP. . .

3.3. Configuring OpenLP 51
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The plugins you have activated will have configure options. If all the plugins are activated there will be 14 items down
the left side you can configure.

3.3.1 General

Application Startup

Show blank screen warning When this box is selected, you will get a warning when opening OpenLP that the output
display has been blanked. You may have blanked it and shut down the program and this will warn you it is still
blanked.

Automatically open the previous service When this box is selected, OpenLP will remember the last service you
were working on when you closed the program.

Show the splash screen The OpenLP logo is displayed while OpenLP loads when this checkbox is checked. This is
useful to give some indication that the program is loading.

Check for updates to OpenLP OpenLP will check to see if there is a newer version available on a regular basis when
this checkbox is checked. Please note that this requires Internet access.
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Logo

Logo file: Select an image file to be displayed when OpenLP is started. Using an image file will override a background
color.

Browse for an image file to display

Revert to the default OpenLP logo

Background color: You can choose the background color that will be displayed when you start OpenLP.

Don’t show logo on startup With this box is checked the OpenLP log will not be displayed on startup.

CCLI Details

CCLI number: If you subscribe to CCLI, this box is for your License number. This number is also displayed in the
Song Footer box.

UI Settings (user interface)

Number of recent files to display Set this number for OpenLP to remember your last files open. These will show
under File → Recent Files.

Open the last used Library tab on startup With this box selected OpenLP Library will open on the same tab that it
was closed on.

Hide mouse cursor when over display window With this box selected your mouse cursor will not be visible if you
move it from Display 1 onto Display 2.

Double-click to send items straight to live With this box selected, double-clicking on anything in the Library will
immediately send it live instead of to Preview.

Preview items when clicked in Library With this box selected, clicking any item in the Library will immediately
display it in the Preview pane.

Preview items when clicked in Service With this box selected, clicking any item in the Service will immediately
display it in the Preview pane.

Expand new service items on creation With this box selected, everything you add to the Service will be expanded
so you can see all the verses, lyrics and presentations, line by line. When you open OpenLP, everything will
automatically be expanded in the Service.

Max height for non-text slides in slide controller With this box selected, on closing OpenLP you will be presented
with a dialog box to confirm closing the program.

When changing slides This dropdown controls how the Live and Preview controllers scroll the verses displayed as
you progress through the item slides.

Include slide number in footer With this box selected, current slide number and total slides number will be visible
in the footer.

Enable search as you type With this box selected, as you type into text boxes suggestions will be shown.

Enable application exit confirmation With this box selected, you will be asked if you really want to close OpenLP.

Alert if New clicked on blank service With this box selected, the warning will be displayed when File - New Service
is being clicked while the existing service is blank.

Interface Theme (needs restart) This dropdown allows to change the UI colour scheme.
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3.3.2 Service

Default service name

The default service name gives you the ability to have a preset name, date and time when saving your service file.

Enable default service name: Checking this box will activate the use of the default service name.

Date and Time: You can choose the regular day of the week and time of the service or choose Now from the dropdown
for the immediate date and time to save your service file.

Name: You can change “Service” to a default name of your choosing. The year, month day, hour and minute will
default to what you have set for Date and Time above or if you chose Now the saved file will have the time and
date that you save it.

Revert: Clicking this button will erase your changes and revert to the default service name.

Example: The example shows how the name, date and time will be displayed for the file name when saving the file.

Note: If the date and time format does not suit your needs and you are technically inclined, there is more information
at Python.org.

Slide Controller

Unblank display when sending items to Live When using the blank to button with this checkbox checked, on going
live with the next item, the screen will be automatically re-enabled. If this checkbox is not checked you will
need to click the blank to button again to reverse the action.

Unblank display when changing slide in live

Automatically preview next item in service When this box is selected, the next item in the Service will be displayed
in the Preview pane.

Timed slide interval: This setting is the time delay in seconds. This is used to continuously loop a group of images,
verses, or the lyrics in a song. This control timer is also accessible on the Using the Service Timer
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Service Item Wrapping

Remain on Slide Up and down arrow keys stop at the top and bottom slides of each Service item. You will need to
use the Right Arrow key or the mouse to move to the next Service Item.

Wrap Around Up and down arrow keys wrap around at the top and bottom slides of each Service item, eg: When
you reach the last slide of a song or verse and Down Arrow you will be back on the first slide. Likewise if you
are on the first slide and Up Arrow you will wrap-around to the last slide of the song, images or Bible verses.

Next Slide Up and down arrow keys advance to the next or previous Service Item from the top and bottom slides
of each Service Item. As long as you have your songs and verses in order, you can use the Down Arrow to
move through your service from start to finish. Using this setting makes it possible to use a presentation remote
controller.

Service Editing

Show confirmation box when deleting item from service

3.3.3 Advanced

Data Location

If you wish to change the default location of where OpenLP stores its data, you can enter a custom location here.

Browse for a custom data location Clicking this button will open the open file dialog and allow you to select
ability new location for the Data directory.

Revert: Clicking this button will erase your changes and revert to the default data location.

Display Workarounds

Ignore Aspect Ratio Selecting this option will allow service items to be displayed as it was originally formated
without regard for how the screen is formated.

Bypass X11 Window Manager Linux and other X users may need to try toggling this flag if the main display win-
dow is causing them problems. For example with this unset, KDE users may find the main display window
disappears if they switch windows. Ubuntu users using the Unity interface may find the main screen is cor-
rupted if set. GNOME Shell users may find the window doesn’t fill the whole screen if unset. As it appears to
affect different versions and distributions differently, this setting has been added, rather than try and work it out
programmatically.
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Use alternating row colors in lists Using alternating row colors in most cases makes it easier for the human eye to
overview a list of items. Uncheck to disable.

Disable display transparency Selecting this option prevents the Live display from being transparent.

Proxy Server Settings

You can select a proxy server if needed. Your network administrator will know if this is necessary. In
most cases this will not be needed.

No proxy Select this option if you do not want to use a Proxy Server.

Use system proxy Select this option if you want to use your computers default Proxy Server.

Manual proxy configuration Select this option if you want to setup the Proxy Server manually. The remaining
options are only active if you select the Manual proxy configuration.

HTTP: Enter the IP address for your proxy server followed by the port to be used on your proxy server. Please use
the 120.002.168.064:4000 format.

HTTPS: Enter the IP address for your proxy server followed by the port to be used on your proxy server. Please use
the 120.002.168.064:4000 format.

Username: Please enter your username if a username is required by you proxy server. Leave this blank if your proxy
server does not require user authenication.

Password: Please enter your password if a username and password is required by you proxy server. Leave this blank
if your proxy server does not require user authenication.

3.3.4 Screens

To choose which monitor you want OpenLP’s Live display on, select the appropriate monitor. If only one screen is
displayed your system has determined you only have one display it can output to. If you are unsure about what display
to use for you Live display select the Identify Screens button.
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Use this screen as display

This box needs to be checked for one display.

Full Screen Select this option if you want to use the full screen area.

Custom geometry This setting overrides the exact position on your screen where the display output appears. If you
have a custom projector setup, click the Override display position checkbox, and manually set the position of
the display output using the X, Y, Width and Height values.

This setting often comes in useful when you only have a single display, and you want to be able to make the
display smaller so that it does not cover your entire screen.

Generic Screen Settings

Display if a Single Screen Checking this checkbox will show the display output in a separate window when you only
have a single monitor. To close the display window, click on it and press the Esc key.

3.3.5 Themes

Global Theme

Choose the theme you would like to use as your default global theme from the drop down box. The theme selected
appears below unless the theme is a movie theme. The global theme use is determined by the Theme Level you have
selected.

Theme Level

Choose from one of three options for the default use of your theme.

Song Level With this level selected, your theme is associated with the song. The theme is controlled by adding
or editing a song in the Song editor and your song theme takes priority. If your song does not have a theme
associated with it, OpenLP will use the theme set in the Service.

Service Level With this level selected, your theme is controlled at the top of the Service. Select your default service
theme there. This setting will override your Song theme.

Global Level With this level selected, all songs and verses will use the theme selected on the left in the Global Theme
drop down.
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Universal Settings

Transition between service items Checking this option will force the theme to use it’s transition between items in
the service (so when you change from a song to a Bible verse you’ll get a transition)

Reload live theme when changed Check this option if you want the theme reloaded when you edit it while it is
currently being used in the current live item.

3.3.6 Media

Live Media

Start Live items automatically With this option selected songs and videos will start to play automatically when sent
live.

VLC (requires restart)

Extra arguments: If needed you can add command line arguments to be used with VLC.

3.3.7 Projectors
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Communication Options

The following options available are:

Connect to projectors on startup Check if you want to attempt to connect to all projectors when OpenLP starts.

Socket timeout (seconds): Time in seconds to wait for the projector connection. Available options are 2 to 10 sec-
onds.

Poll timeout (seconds): How often to poll the projector for status information. Available options are 2 to 60 seconds.
For quicker response on the status icons, set to a lower value. If you have network congestion, you may need to
use a higher value.

Source select dialog interface: Select whether you want all video source options on one dialog page or to use tabs to
consolidate the inputs based on video group.

Enable listening for PJLink2 broadcast messages Select this option to Enable listening on UDP ports for PJLink2
broadcasts.

Convert to projector when LINKUP received Select this option so a projector can be enabled when the LINKUP
signal is received from the projector.

3.3.8 Remote Interface

OpenLP gives you the ability to control the Service or send an Alert from a remote computer through a web browser.
This could be useful for a nursery or daycare to display an Alert message or, use it as an interface to control the whole
service remotely by a visiting missionary or worship team leader.

Stage view gives you the opportunity to set up a remote computer, netbook, tablet or smartphone to view the service
being displayed in an easy to read font with a black background. Stage view is a text only viewer.

The remote feature will work in any web browser that has network access whether it is another computer, a netbook
or a smartphone. You can find more information about this feature here: The Web Remote.

Note: To use either of these features, your computers will need to be on the same network, wired or wireless.
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Server Settings - Non Secure

Listen IP address: Put your OpenLP computer’s IP address here or use 0.0.0.0 which will allow to listen on all
network interfaces.

Display stage time in 12h format This setting displays the time in stage view in 12h or 24h format.

Show Thumbnails of non-text slides in remote and stage view Check this option if you want to see thumbnails of
non-text slides on the Stage and Remote Views.

Port Number: You can use the default port number or change it to another number. If you do not understand this
setting you should leave it as is.

Remote URL Using the remote URL, you have the ability to control the live service from another computer, netbook,
tablet or smartphone using a web browser.

Stage view URL Using stage view gives you the ability, using a remote computer, netbook or smartphone, to view the
live service display in a basic black and white format. This URL shows the address you will use in the remote
browser for stage view.

Chords view URL Using the chord view adds chords to the Stage view lyrics. This can be helpful when the stage
view is used for the musicians that play the cords.

Live view URL Using the live view, you can display the Live output on multiple devices.
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User Authentication

This option allows the additional security for update functions via the remote interface. Once the userid and password
have been accepted then updates will be possible for duration of the web session. This option can be changed without
the need to restart OpenLP.

Web Remote

Installed version The current version of the remote interface is displayed here. If the current version is different from
the latest version, press the Upgrade button.

Latest Version The latest version of the remote interface is displayed here after you press the Check for Updates
button.

Remote App

You can quickly navigate your phone or tablet to the Remote Interface using QR code reader.

Finding your IP address

If the Remote or Stage view URL are not showing you can manually find these settings. To find your projection
computer’s IP address use these steps below.

Windows:

Open Command Prompt and type:

C:\Documents and Settings\user>ipconfig

Press the Enter key and the output of your command will display the adapter IP address. The IP address have a
format of x.x.x.x where x is in range 0-255.

Linux:

Open Terminal and type:

linux@user:~$ifconfig

Press the Enter key. This will display a fair amount of technical information about your network cards. On most
computers, the network card is named “eth0”. The IP address for your network card is just after “inet addr:” in the
section with your network card’s name. The IP address have a format of x.x.x.x where x is in range 0-255.

OS X

From the Apple menu, select System Settings → Network. Select active network connection (e.g. Wi-Fi, Ethernet,
AirPort, modem). If you are connected, you’ll see its IP address under the “Network Settings. . . ” menu.

With these IP address written down, open a web browser in the remote computer and enter the IP address followed
by a colon and then the port number, e.g. 192.168.1.104:4316 then press Enter. You should now have access to the
OpenLP Remote view. If it does not come up, you either entered the wrong IP address, port number or one or both
computers are not connected to the same network.
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3.3.9 Songs

Song related settings

Enable `Go to verse` button in Live panel With this box selected, a Go To drop down box is available on the live
toolbar to select any part of the song. You can also type you the part of the song you want displayed on live
display.

Update service from song edit With this box selected and you edit a song in the Library, the results will also change
the song if it is added to the Service. If this box is not selected, your song edit changes will only be available in
the Service if you add it again.

Import missing songs from service files With this box selected, when you open a service file created on another
computer, or if one of the songs are no longer in your Library, it will automatically enter the song in your Songs
Media Manager. If this box is not checked, the song is available in the service but will not be added to the
Library.

Add Songbooks as first slide With this box selected the songbook name for songs (if available) will be shown as an
introduction slide for the song. This option is implemented as songs are added to the Service. If you already
have a song in the service, you will need to remove the song and re-add the song to the service for the songbook
name slide to be added to the song.

Auto-play background audio With this box selected the linked audio will be played automaticaly when item is
selected.

Chords

Enabling this option allows songs with chords to show the chords on the Stage views. Any text in the
song that is between “[” and “]” will be regarded as chords.

Ignore chords when importing songs This option will allow the song importer to ignore cords in the imported song.

Warn about missing song key This option will display warning when no song key is defined before the first chord
used in the song. E.g. [=G][G] . . .

Chord notation to use Select the English, German or Neo-Latin notation to match your location or need.
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SongSelect Login

You must have a valid SongSelect account to use this option. Type in your username and password to
enable automatic login when importing SongSelect songs.

Footer

This is a list of the Placeholders that can be used in the Footer Template.

Footer Template

You can cutomize the Footer information for a song. To make changes click into the text box and type
your changes. If you need to reset the template, press the Reset Template button.

3.3.10 Bibles

Verse Display

Show verse numbers With this box selected verse numbers are always shown, deselect to hide verse numbers.

Only show new chapter numbers With this box selected, the live display of the verse will only show the chapter
number and verse for the first verse, and just the verse numbers after that. If the chapter changes, the new
chapter number will be displayed with the verse number for the first line, and only the verse number displayed
thereafter.

Display style This option will put brackets around the chapter and verse numbers. You may select No Brackets or
your bracket style from the drop down menu.

Layout style There are three options to determine how your Bible verses are displayed.

• Verse Per Slide: Will display one verse per slide.

• Verse Per Line: Will start each verse on a new line until the slide is full.

• Continuous: Will run all verses together, separated by verse number and chapter (if chapter is selected to
show above).

• Continuous (whole verses): Will run all verses together, separated by verse number and chapter (if chapter
is selected to show above). This will only add the next verse if it wholly fits on the slide. If it does not fit,
it will begin a new slide.

Note: Changes do not affect verses already in the service.
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Display second Bible verses OpenLP has the ability to display the same verse in two different Bible versions for
comparison. With this option selected, there will be a Second choice in the Bible Media Manager to use this
option. Verses will display with one verse per slide with the second Bible verse below.

Bible theme You may select your default Bible theme from this drop down box. This selected theme will only be
used if your Theme Level is set at Song Level.

Note: Changes do not affect verses already in the service.

Custom Scripture References

Here you can change the default separators used in the scripture references. The default values are shown in gray when
the custom separators has not be enabled and nothing has been entered. Note that the default separators can change if
the language of OpenLP is changed.

Verse Separators: Enable to enter a custom verse separator.

Range Separators: Enable to enter a custom range separator.

List Separators: Enable to enter a custom list separator.

End Mark: Enable to enter a custom end marker.

Default Bible Language

Choose the language of the bible books. The options are:

Bible Language The language of the books will be determined by the language of the bible.

Application Language The language of the books will be determined by the language set for OpenLP.

English The language of the books will be set to English.

Quick Search Settings

Reset search type to `Text or Scripture Reference` on Startup Select this option if you want the bible search type
to be Text or scripture Reference when OpenLP is started.

Don’t show error if nothing is found in `Text or Scripture Reference` Select this option to remove the error mes-
sage when there are no results for your text or scripture reference search.

Seach automatically while typing Select this option if you want a display of possible results to appear as you type
in your search criteria. The list will appear after 8 charactors are entered or a space is entered.
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3.3.11 Presentations

Available Controllers

OpenLP has the ability to import OpenOffice Impress or Microsoft PowerPoint presentations, and use Impress, Pow-
erPoint, or PowerPoint Viewer to display and control them from within OpenLP. Please remember that in order to use
this feature you will need to have one of the above-mentioned applications installed, due to the fact that OpenLP uses
these application to open and run the presentation.

Support of PDF is bundled with OpenLP on macOS and Windows. On Linux you will need to install mupdf (recom-
mended) or ghostscript.

Advanced

Allow presentation application to be overridden With this option selected, you will see Present using area with a
dropdown box on the Presentations toolbar in the Library Presentations which gives you the option to select the
presentation program you want to use.

PowerPoint options

These options are only available if PowerPoint has been detected.

Clicking on a selected slide in the slidecontroller advances to next effect When this is enabled it is possible to go
to the next effect of a slide by clicking the slide in the slidecontroller. The default behavior is to restart the slide.

Let PowerPoint control the size and position of the presentation window (workaround for Windows 8 scaling issue)
Windows 8 and 10 can on computers with multiple monitors use scaling to make windows look the same size
on different monitors. Unfortunately this can cause issues with how OpenLP places and resizes the PowerPoint
presentation window. Check this box to enable the workaround which let PowerPoint control the presentation
window. When you enable this you must setup PowerPoint to present to the correct monitor.
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Impress options

Use Impress Slide Show Settings / Presentation Display Setting

3.3.12 Images

Provides border where an image is not the correct dimensions for the screen when it is resized.

Image Background

Use Blank Theme Select this option to place the image on a blank background. If the image is smaller than the
screen, the area around the imabe will be black.

Custom Theme Select this option and use the dropdown box to use one of the current themes as a background for the
imate.

3.3.13 Custom Slides
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Custom Display

Display Footer With this option selected, your Custom slide Title will be displayed in the footer.

Note: If you have an entry in the Credits box of your custom slide, title and credits will always be displayed.

Import missing custom slides from service files With this box selected, when you open a service file created on
another computer, or if one of the custom slides are no longer in your Library, it will automatically enter the
custom slide in your Custom Slide Media Manager. If this box is not checked, the custom slide is available in
the service but will not be added to the Library.

3.3.14 Alerts

Font Settings

Font name: Choose your desired font from the drop down menu

Font color: Choose your font color here.

Background color: Choose the background color the font will be displayed on.

Font size: This will adjust the size of the font.

Background Settings

Background Color Select the color box and you can select the background color for the alert.

Enable Scrolling

Select this option and the alert text will scroll across the screen.

Repeat(no. of times) If Enable Scrolling has been selected this sets the number of times the alert will scroll across
the screen.

3.3. Configuring OpenLP 67



OpenLP Reference Manual, Release 3.0

Other Settings

Alert timeout: This setting will determine how long your Alert will be displayed on the screen, in seconds.

Vertical Align Choose the location where you want the alert displayed on the screen, Top, Middle or Bottom.

Preview

Your choices will be displayed here.

3.4 Configuring the Main Window

The main window is configurable. By default there are three screen layouts and each can be configured as you desire.
To change to one of the screen layouts, use the View menu.

3.4.1 Hiding the window items

The first way to configure the main window is to Hide items that are not used.

If you are not using the Projector Manager, having it open all the time uses up part of the window that could be used
for other items. To hide the Projector Manager, or any other item, left click on the ‘X’ in the right corner of the item.
You can also use the View menu to hide or show any of the main window items.

3.4.2 Re-Sizing the window items

If you use the item part of the time, you can re-size the item in the same manner you re-size any window on the desktop
by placing your pointer over the edge of the item and pulling the edge in or out to re-size the item .

3.4.3 Change the Location of an item in the window

There are four zones the items can be located in addition to keeping the item as a seperate window.

1. Left Side of the window

2. Right Side of the window

3. Top of the window

4. Bottom of the window

To move an item, move the mouse over the item title bar and press and hold the left mouse button while draging the
item to a new location. When the item is in a location that the item can be located at, the area will turn blue to indicate
the item can be placed at that location. Releasing the left mouse button will place the item at that location.
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3.4.4 Tab Locating an item

By default the items in the main window are located above, below or to the side of other items in the window. Most
of the items can also be located in a Tab arrangement. This arrangement allows the item to be full sized, and to be
viewed by selecting a Tab at the bottom of another item in the window.
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To create a Tab located item, move the mouse over the item title bar then press and hold the left mouse button while
draging the item to a new location on top of another item in the window. When the item is in a location that the item
can be placed at, the area will turn blue to indicate the item can be located at that location. Releasing the left mouse
button will create the Tab location with the item you moved and the item or items displayed in blue.
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3.4.5 Locking and Un-Locking the panels

To prevent the panels from changing accidently you can lock the panels. After you have made your changes to the
panels, lock the panels using the View menu Lock Panels menu item. By selecting the Lock Panels menu item a second
time you can unlock the panels.

3.5 Backing up OpenLP

3.5.1 Backing up data files

OpenLP gives you the ability to directly access your data files making your data easy to back up. Using the menu
items at the top click on Tools → Open Data Folder. . . .

You will be presented with the folder where all of the OpenLP data files are stored in their individual folders.
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You can select an individual folder or all of the folders and copy your data to your choice of media or a flash drive.
This is also an easy way to get all of your data onto another computer that is running OpenLP.

You can restore your data folders and files by copying them back into your data folder Tools → Open Data Folder. . . .
You will overwrite all of your original data with the data you are copying back into the folder.

Warning: Once you overwrite your data there is no way to retrieve your original data.

Note: If you copy your data files back into the OpenLP data folder you must shut down OpenLP and restart it to see
the changes.

3.5.2 Export Settings

OpenLP stores all of the configuration settings in a configuration file for Linux and OS X or the Window’s registry.
Once you have OpenLP configured to your liking you should backup your settings. This is done from the menu item
at the top by clicking on File → Export → Settings.
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You will then be presented with a window to choose what to name and where you want to save your configuration file.
Click Save.

3.5. Backing up OpenLP 73



OpenLP Reference Manual, Release 3.0

3.5.3 Import Settings

You can import OpenLP configuration settings from a previous backuped up configuration file or from an exported file
from another computer. This is done from the menu item at the top. by clicking on File → Import → Settings.
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Please read the complete warning and click Yes to continue or No to cancel.

You will then be presented with a window to find and restore your saved configuration file. Click on the configuration
file and click Open.
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Your configuration settings will be imported. Click on Ok to restart OpenLP.
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3.6 Dual Monitor Setup

The first step in getting OpenLP working on your system is to setup your computer properly for dual monitors. This
is not very difficult, but the steps will vary depending on operating system.

Most modern computers have the ability for dual monitors. To be certain, check your computer’s documentation. A
typical desktop computer capable of dual monitors will have two of, or a combination of the two, connectors below.

VGA

DVI

HDMI

S-Video

A laptop computer setup varies slightly. Generally you will need only one of the outputs pictured above since your
laptop screen serves as one of the monitors. Some older laptops may require a key stroke generally involving the Fn
key and another key (labeled on the keybaord) to enable the second monitor.

A typical OpenLP setup consist of your normal single monitor, with your projector hooked up to your computer as
the second monitor. With the option of extending your desktop across the second monitor, or your operating system’s
equivalent.
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Special Note For Projectors Using USB Connections

Users have reported experiencing difficulties when using a projector with a USB connection. Third party software is
often required to properly configure dual monitors. If possible, it is best to use a direct output (VGA, DVI, HDMI,
S-Video) from your machine’s video card. If a USB connection is your only option please consult the manufacturer’s
manual for instructions on a proper setup.

3.6.1 Microsoft Windows

Dual monitor setup is similar among all the currently supported Windows releases (Windows 8 & 10, Windows 7,
Windows Vista), but does vary slightly from one release to the next.

Windows 8 & 10

When using Windows 8 and 10 enabling your projector is easy. Simply connect your projector and press Windows+P.

The more traditional way is also fairly straight forward. Go to Control Panel and click on Adjust screen resolution
under Appearance and Personalization.

This will open up a window for configuring your screens. Enable your projector and make sure that the selected value
for Multiple displays is Extend these displays.
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On Windows 10 there is also a different way of configuring your screens. By right-clicking on the desktop and
choosing Display settings a different configuration window will appear.
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To change the resolution of the screens you will have to click Advanced display settings.

Recommendations

Windows 8 and 10 have several features that might seem smart on a normal desktop but which is not something that
should be enabled when you want to use the computer for presenting songs, etc. during a service.
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Right click the task bar and choose Properties. You should uncheck Use Peek to preview. . . since it will totally blank
the 2nd display if hovering mouse over an icon on the taskbar. You should also uncheck Show taskbar on all displays.
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If you use Windows 10 you should probably also hide the Task View button from the taskbar, since clicking it will
blank your 2nd display. To disable it, right click the taskbar, and uncheck Show Task View button.

Windows 7

Windows 7 has using a projector in mind. Simply connect your projector and press Windows+P.

The more traditional way is also fairly straight forward. Go to Control Panel and click on Display. This will open
up the Display dialog. You may also bypass this step by a right click on a blank area on your desktop and selecting
Resolution.
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Then click on the Adjust resolution link in the left pane. Enable your projector and make sure that the selected value
for Multiple displays is Extend these displays.
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Windows Vista

From Control Panel click on Personalize, or right click a blank place on the desktop and click Personalization.
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From the Personalization window click on Display Settings. Click on the monitor that represents your projector and
make sure you have checked Extend the desktop onto this monitor.
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3.6.2 Linux

Due to the vast varieties of hardware, distributions, desktops, and drivers this is not an exhaustive guide to dual monitor
setup on Linux. This guide assumes you have properly set up any proprietary drivers if needed. You should seek out
your distributions documentation if this general guide does not work.

Note to Ubuntu Users: Standard Ubuntu uses the Unity interface. Unfortunately we cannot recommend using Unity
for a dual display setup with OpenLP, since there seems to be no reliable way to hide the menubar from the secondary
display, as well as other issues. Instead we recommend using a different desktop environment like GNOME, KDE
or Xfce, all of which are available from the Ubuntu repositories, and via special Ubuntu variants, such as Ubuntu
GNOME, Kubuntu or Xubuntu.
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GNOME 3

This guide is for users of the GNOME 3 or GNOME Shell desktop who do not use proprietary drivers. In GNOME
shell in the search box type Displays or in GNOME shell or fall back mode go to Applications → System Tools →
System Settings then select Displays.

By clicking on each of the displays listed you can change the mode, resolution and orientation of the displays.

Make sure to put the display you plan to use for presenting to be the Secondary Display.
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Back in the Displays window, click Arrange Combined Displays to arrange the displays. If after setting up your
monitors you have the top panel on the wrong monitor simply drag it to the monitor you want to serve as the primary
screen.

KDE

This guide is for users of the KDE desktop who do not use proprietary drivers. From most distros click the Kick Off
menu and navigate to System Settings
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Click on the Display and Monitor icon.
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From here you will need to set up your projector with the appropriate resolution, and position. OpenLP works best
projecting to the monitor on the right.
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Xfce4

This guide is for users of the Xfce4 desktop. Open the Xfce4 menu and chose Settings Manager.

Open Display to open the settings for displays.

3.6. Dual Monitor Setup 91



OpenLP Reference Manual, Release 3.0

If the second display has not yet been enabled, enable it by selecting it in the window and tick Use this display.

There is an issue with the Xfce4 compositor that makes OpenLP freeze when using a dual monitor setup. This issue
can be worked around by disabling an option for the compositor. To do this open Settings Manager and open Window
Manager Tweaks.
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Go to the Compositor tab and disable Display fullscreen overlay windows directly. Click Close and now OpenLP
should run without issues.

Linux Systems Using nVidia Drivers

This guide is for users of the proprietary nVidia driver on Linux Distributions. It is assumed that you have properly
setup your drivers according to your distribution’s documentation, and you have a working xorg.conf file in place.

If you wish to make the changes permanent in setting up your system for dual monitors it will be necessary to modify
your xorg.conf file. It is always a good idea to make a backup of any critical file before making changes:

user@linux:~ $ sudo cp /etc/X11/xorg.conf /etc/X11/xorg.conf.old

For those using systems that use the root user instead of sudo, change to root and enter:

root@linux: # cp /etc/X11/xorg.conf /etc/X11/xorg.conf.old

The exact location of the xorg.conf file can vary so check your distribution’s documentation.

If you want to make your changes permanent run nVidia settings from the terminal:
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user@linux:~ $ sudo nvidia-settings

Or, as root:

root@linux: # nvidia-settings

If you do not want to write the changes to your xorg.conf file simply run the nVidia Settings program
(nvidia-settings) from your desktop’s menu, usually in an administration or system menu, or from the ter-
minal as a normal user run:

user@linux:~ $ nvidia-settings

Once you have opened nVidia Settings, click on X Server Display Configuration. Select the monitor you are wanting
to use as your second monitor and click Configure.

After clicking Configure, select TwinView and click OK.
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Click Apply and if you are happy with the way things look click Keep to save your new settings. Don’t worry if
something goes wrong, the settings will return back to the previous settings in 15 seconds without any action. nVidia
Settings should take care of selecting your optimum resolution etc, but that can be changed as needed. When you are
happy with everything click on Save to X Configuration File.

Click Save and you should be set. You may want to restart X or your machine just to make sure all the settings carry
over the next time you log in.

Linux Systems With Intel Video

Generally systems with Intel video cards work very well. They are well supported by open source drivers. There are,
however, a couple of issues that may require some work arounds.

Resolution Issue

There is a limitation with certain cards which limits the total resolution to 2048x2048, so both monitors can not have
a total resolution totaling more than that. To work around this it may be necessary to position your monitor as a top or
bottom monitor as opposed to the typical side by side setup. This can easily be accomplished through your desktop’s
control of monitors. Please see the sections on dual monitors with KDE and GNOME above.

Primary Monitor Issues

With certain cards your system may get confused on which is the primary display. For example many users will be
using a laptop. You will want your laptop screen to be the primary screen, and your projector to be the secondary
monitor. Certain Intel cards reverse this. To work around this you will need to know the name of your monitor. If
you are a KDE user this info is given to you in the display settings. If you are not using KDE enter the following in a
terminal without your projector connected to your computer:

user@linux:~ $ xrandr -q

This will give you a long string of output. Screen names will be something along the lines of LVDM, VGA-0 or some
convention similar to that. Without your projector connected to your computer only one monitor will show as being
connected. That will be the monitor you will need to use as the primary. Now connect your projector and enter:
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user@linux:~ $ xrandr --output LVDM --primary

Note it has been reported that when this issue is occurring you will not want to connect your projector until your
desktop is running.

3.6.3 macOS

This short guide will tell users of macOS how to setup dual displays.

Open System Preferences in the Apple menu.

Choose the Displays option.
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Click Arrangement in the top of the window. Make sure that Mirror Displays is unchecked. You can now arrange the
displays as you wish.
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3.7 Library

Once you get your system set up for OpenLP you will be ready to add content to your Service Manager. This will all
happen through the Library. The Library contains all the Bibles, Songs, Presentations, Audio files, Visual files, and
Custom Slides that you will project through OpenLP.

If you don’t see the “Songs”, “Bibles” and other library items in the Library, then refer to The Library appears to be
missing some features in the troubleshooting guide.
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3.7.1 Songs

Clicking on Songs in the Library will display the songs library item. The songs library item shows a list of all the
songs in the songs database.
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Toolbar

Add song Open the song edit dialog to add a new song.

Edit song Open the song edit dialog to make changes to the selected song.

Delete song Remove the selected song(s) from the song list.

Maintain authors, topics and books Open the song maintenance dialog to add, edit or delete authors, topics or
song books.

Preview song Send the selected song to the Preview Slide Controller.

Send song live Send the selected song to the Live Slide Controller to be shown on the display screen.

Add song to service Add the selected song(s) to the Service Manager. Songs can also be added to the Service
Manager by means of drag and drop from the Library.

Note: Right-clicking on a song in the list will display some of the same options and Clone option.

Search

Clicking on the icon in the search box displays a list of search options. The following options are available:

Entire Song Search the title, lyrics and comments fields.

Titles Search the title field only.

Lyrics Search the lyrics field only.

Authors Search the associated authors.

Topics Search the assigned topics.

Songbooks Search the assigned songbooks.

Themes Search the assigned themes.

Copyright Search the assigned copyrights.

CCLI number Search the assigned copyrights.

Click the Search button to perform a search and display the results in the song list.

3.7. Library 101



OpenLP Reference Manual, Release 3.0

3.7.2 Bibles

Clicking on Bibles in the Library will display the Bibles item. The Bibles item shows Bible verses and provides a
search function to find Bible verses and add them to the Service Manager.
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Toolbar

Import Bible Import Bibles from a number of formats. This is discussed in detail on the Bible Import Wizard page.

Edit the selected bible Edit meta data or book names of the selected bible.

Delete the selected bible Delete the selected bible.

Preview verses Send the selected verses to the Preview Slide Controller.

Send verses live Send the selected verses to the Live Slide Controller to be shown on the display screen.

Add verses to service Add the selected verses to the Service Manager. Verses can also be added to the Service
Manager by means of drag and drop from the Library.

Note: Right-clicking on a selection of verses will display some of the same options.

Find Tab

The following options are available on the quick search tab:

Find: Clicking the icon in the Find box displays a list of search options. The following options are available:

Text or Reference Search by keyword or using scripture reference format. See below.

Scripture Reference Search for a specific verse using a scripture reference format. Below is some examples
on supported formats:

• Book Chapter

• Book Chapter-Chapter

• Book Chapter:Verse-Verse

• Book Chapter:Verse-End (this will display verses to the end of the chapter)

• Book Chapter:Verse-Verse, Verse-Verse

• Book Chapter:Verse-Verse, Chapter:Verse-Verse

• Book Chapter:Verse-Chapter:Verse
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Note that the separators might change depending on the language chosen for OpenLP. See and customise
separators under Setttings → Configure OpenLP on the Bibles tab.

A detailed description of the format and how it is parsed by OpenLP can be read In the OpenLP API
documentation.

If an invalid format is used for a search a popup window will show the examples also shown above.

Text Search Search by a keyword or words. Use more words to narrow down the list of results. If you search
for “Jesus God” it searches sentences which contain both words, Jesus and God. If you search for “Jesus,
God” separated by a comma, it searches for sentences which contain at least one of the words, Jesus or
God.

Clear Tab Contents This will clear the results on the currently active tab (Saved or Results).

Save Results This will add contents of the Results tab to the Saved tab.

Click the Search button to perform a search and display the results in the verse list.

Select Tab

The Advanced tab is convenient for selecting Bible verses by book, chapter and verse from a set of drop down boxes.

Book Click on the drop down box and select a book from the list.

Chapter/Verse Select the From chapter and verse, and the To chapter and verse.

Click the Search button to perform a search and display the results in the verse list.
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Options Tab

Version Once a Bible has been imported, it will be displayed in the drop down box. Select a version from the list of
the Bibles.

Second If Display second Bible verses has been selected in the Bibles configuration, this option will be available.
This is used to display another version of the Bible for comparison. Both versions will be displayed. If there is
not enough space on one slide, the Second verses will be displayed on the next slide.

Layout style There are three options to determine how your Bible verses are displayed.

• Verse Per Slide: Will display one verse per slide.

• Verse Per Line: Will start each verse on a new line until the slide is full.
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• Continuous: Will run all verses together, separated by verse number and chapter (if chapter is
selected to show above).

• Continuous (whole verses): Will run all verses together, separated by verse number and chapter
(if chapter is selected to show above). This will only add the next verse if it wholly fits on the
slide. If it does not fit, it will begin a new slide.

This setting is also accessible in Setttings → Configure OpenLP on the Bibles tab.

Note: Changes to layout style do not affect verses already in the Service Manager.

3.7.3 Presentations

Clicking on Presentations in the Library will display the presentations item. The presentations item shows a list of
imported presentations.

3.7. Library 107



OpenLP Reference Manual, Release 3.0

108 Chapter 3. Reference Manual



OpenLP Reference Manual, Release 3.0

Toolbar

Load presentation Import a presentation. Presentations need to be imported in order to control them from within
OpenLP.

Delete presentation Removes the selected presentation from the list. Note that this does not delete the original
presentation from the disk.

Add group Opens a dialog where a new group can be added.

Preview presentation Send the selected presentation to the Preview Slide Controller.

Send presentation live Send the selected presentation to the Live Slide Controller to be shown on the display
screen.

Add presentation to service Add the selected presentation to the Service Manager. Presentations can also be
added to the Service Manager by means of drag and drop from the Library.

Notes: Right-clicking on a presentation will display some of the same options.

Presentation items can be dragged from the desktop (or any folder) into the Presentation library plugin. This allows the
selected items to be loaded more quickly. If a folder is selected, all the contacts of the folder will be added. When the
items are added, only items with the correct file suffix for the plugin will be loaded. If you try to drop a presentation
into the images folder, an error message will be generated.

In Presentations configuration it is possible to enable Allow presentation application to be overridden, which shows
a dropdown box which gives you the option to select the presentation application you want to use. The default is
Automatic, but you can choose any available presentation application. Note that this can lead to unexpected behavior
if the application chosen is not compatible with the presentation.
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3.7.4 Images

Clicking on Images in the Library will display the images item. The images item shows a list of imported images.
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Toolbar

Load image Import one or more images. Images need to be imported in order to be used in OpenLP.

Delete images Removes the selected image(s) from the list. Note that this does not delete the original image(s)
from the disk.

Add group Opens a dialog where a new image group can be added.

Replace live background: Replace the current live theme background with the selected image. This has effect
until the theme changes, or the Remove Backgound button is clicked.

Preview image Send the selected image(s) to the Preview Slide Controller.

Send image live Send the selected image(s) to the Live Slide Controller to be shown on the display screen.

Add image to service Add the selected image(s) to the Service Manager. Images can also be added to the Service
Manager by means of drag and drop from the Library.

Notes: Right-clicking on an image will display some of the same options.

When an image is added to the library, a dialog will ask in which group the image should be placed. The options are
No group, Existing group or New group.

Images can be dragged from the desktop (or any folder) into the Images manager plugin. This allows the selected
items to be loaded more quickly. If a folder is selected, all the contacts of the folder will be added. When the items
are added, only items with the correct file suffix for the plugin will be loaded. If you try to drop a presentation into the
images folder, an error message will be generated.
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3.7.5 Media

Clicking on Media in the Library will display the audio or video files in the Library.

Note: On some computers OpenLP has trouble displaying videos. Please read the Troubleshooting for tips on how to
resolve these issues.
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Toolbar

Load new media

Load CD/DVD This feature only works if VLC is installed on the computer and enabled in OpenLP. See
Media for how to configure media players. Clicking the icon will bring up a window where you can
load a DVD or audio CD, select a track and a range and save it as a named clip. Note that the audio
CD or DVD is still required when playing the clip, even if the clip is saved to a service file.

Open device stream Connect to a video stream that is physically connected to the OpenLP com-
puter.

Open network stream Connect to a video stream that is accessable over the network connected to
the OpenLP computer.
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Delete the selected media Removes the selected audio or video file(s) from the list. Note that this does not delete
the original file(s) from the disk.

Preview the selected media Send the selected audio and video files to the Preview Slide Controller.

Send the selected media live Send the selected audio or video file to the Live Slide Controller to be shown on the
display screen.

Add the selected media to the service Add the selected audio and video files to the Service Manager. Audio and
video files can also be added to the Service Manager by means of drag and drop from the Library.

Notes: Right-clicking on a audio or video file will display some of the same options.

Audio and video items can be dragged from the desktop (or any folder) into the Media manager plugin. This allows the
selected items to be loaded more quickly. If a folder is selected, all the contacts of the folder will be added. When the
items are added, only items with the correct file suffix for the plugin will be loaded. If you try to drop a presentation
into the images folder, an error message will be generated.

In Media configuration it is possible to enable Allow media player to be overridden, which shows a dropdown box
which gives you the option to select the media player you want to use. The default is Automatic, but you can choose
any available player.

3.7.6 Custom Slides

Clicking on Custom Slides in the Library will display the custom slides libruary item. The custom slides item shows
a list of custom textual items. Custom slides are useful for creating unstructured text items, such as liturgy or prayers.
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Toolbar

Add custom slide Open the song edit dialog to add a new custom slide.

Edit custom slide Open the song edit dialog to make changed to the selected new custom slide.

Delete custom slide Remove the selected custom slide(s) from the list.

Preview custom slide Send the selected custom slide to the Preview Slide Controller.

Send custom slide live Send the selected custom slide to the Live Slide Controller to be shown on the display
screen.

Add custom slide to service Add the selected custom slide(s) to the Service Manager. Custom slides can also be
added to the Service Manager by means of drag and drop from the Library.

Note: Right-clicking on a custom slide in the list will display some of the same options.

3.8 Service

Now that you have OpenLP set up the way you want, it is time to put it to use.

Everything you need to display will be in the left panel called the Library, under their respective categories. Using
the Library you can add new media, songs, images, Bibles or create a custom slide as discussed earlier in the Library
section.
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On the right side of your screen at the top is the Service Manager. Everything you want to display should be in the
Service Manager and preferably in the order you want to display it.
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3.8.1 New, Open and Saving the Service

Three icons at the top of the Service Manager will do the following:

Create a new service This first icon will create a New Service.

Load an existing service This second icon will open an already created service file. Use this icon to to find the
location of your file or you can open a saved service by dragging and dropping it into the service manager. The
service will be opened and the existing service replaced. You will first be prompted to save your previous service
if changes were made.

Save this service This icon will Save the service you created, added to or rearranged. The order of service, songs,
images, Bible verses, service notes, and custom slides are all saved in the file.

3.8.2 Changing the Service Level Theme

If you click on the Theme dropdown, you have the option to set the Service level theme. This option is covered in
greater detail under Themes.

Note: This feature is only available if you have the Theme level set to Service or Song Level in Themes.

3.8.3 Editing Songs in the Service

You can create your service file on a different computer than the projection computer. If a song is not in the projection
computer database when you open the saved file OpenLP will automatically import the song into the song database
with this option checked here Songs “Import missing songs from Service file”.

You always have the ability to edit the song in the service manager by right clicking on the song and choosing Edit
Item from the context menu. Follow the directions here Creating or Editing a Song Slide to make changes to your
song.

Note: Editing a song in Service will be applied to the Service song database. Editing a song in the Library will be
applied to the song in your Library. This can be changed so that changes made in the Service song database update
the Library song database and changes made in the Library song database update the Service song database in Song
related settings.

3.8.4 Working with Service Items

To add your media you can drag and drop your selection from the Library to the Service Manager or, after clicking the
media or verse you want to use, click the . This will add your selected item to the Service manager at the bottom.

Note: You always have the option to send any media live direct from the Library. Please see the Library section for
more details.

Sorting Service Items

Once there are some items in the Service Manager you can click on your item and drag and drop it in the order you
want or, click the item and use the icons shown below to move it up or down.

Move item to the top of the service.

Move item up one position in the service.

Move item down one position in the service.

Move item to the end of the service.

Expanding and collapsing Service items
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To view your Bible or song verses one by one, use the icons below. This is a convenient way to move around through
the verses if they are skipped or repeated. Double-click on the verse you want to display live.

Expand all the service items.

Collapse all the service items.

As an alternative to expanding or collapsing all items in the list you can use the buttons to the right of a list item to
expand or collapse a single list item.

Expand a single service item.

Collapse a single service item.

Common operations on Service items

Send the selected item to Live.

Remove the service item.

3.8.5 Displaying an Item

When you have all of your items needed for the service in your Service Manager there are a few ways to get them to
display on the screen. You can double-click the item, click it once with the mouse and push the Enter key, right click
the item and left click Go Live or click it once with the mouse and click on the Sent to Live button at the bottom of
the Service Manager.

Any of these methods will display your item on the screen. When your item is displayed, it will be selected in the
Slide controller just to the left of the Service Manager and Live preview will be visible in the bottom part of the Slide
controller.
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To Preview an item in the left Preview pane, right click the item and left click Show Preview.

3.8.6 Changing a Service Item Theme

When you get your Service items set up and you notice you don’t have the correct theme for it, you can right click the
item and choose your preffered theme using Change Item Theme menu list.

3.8.7 Moving Through the Service Items

When you display a song or Bible verse with multiple verses you will need to move through them. Depending on
which panel is in focus you can use your keyboard in various ways.

Using Enter key in Service manager will Send to live selected item/slide and the subsequent Up Arrow or Down
Arrow keys will change slides/items in the Live pane. At the same time Left Arrow/Right Arrow will jump
to previous/next Service item.

When the focus is in Service manager you can use the Right Arrow/Left Arrow key to expand/collapse Service
items. Up Arrow or Down Arrow will not force slide change in Live.

Alternative options to changing slides

In Live pane you can also use following buttons to change slides:

Move to next.

Move to previous.

Page Up and Page Down keys will do the same thing.

Note: You can also use Down Arrow to go through each slide in the Service item and once it reaches the last slide it
switches to the next Service item. See configuration options in Service Item Wrapping.

124 Chapter 3. Reference Manual



OpenLP Reference Manual, Release 3.0

3.8.8 Changing slides using keyboard shortcuts

There is shortcut support for the Live Controller in OpenLP. This allows you to navigate through, and jump between,
your slides in the Live Controller using only your keyboard. This works for any type of slides, e.g. songs, Bible verses
and images.

How does it work?

If you want to jump to verse 3 using the keyboard you press v and within a time frame of 350ms you press 3. Keep in
mind to be quick and you will be successful.

The available keyboard shortcuts are:

• Verse: v

• Chorus: c

• Bridge: b

• Pre-Chorus: p

• Intro: i

• Ending: e

• Other: o

• and the numbers from 0-9

3.8.9 Adding a Group of Images

At some point you may have a group of images to display together. It may be pictures from a youth group adventure,
bulletin announcements, or some other reason. You can either create the group in the Library and then click the icon
above the images, or you can manually select a group of images. Do this by holding the Ctrl key on your keyboard
and click each image you want to add as a group. As you click the images they will remain highlighted. When you are
done with your selections you can either click the icon above the images or, click on one of the highlighted images,
hold the mouse button and drag them over to the Service Manager side and place them where you need them.
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3.8.10 Sorting a Group of Images

If you do not like the order the images are in, right click Images.

Left click Reorder Item.

From this box you will be able to rearrange the order of your images by clicking on one and using the Up and Down
arrows to move it to where you want it. If there is an image you do not want in your order, click on it and then click
the Delete button. When you are done arranging your images click Save.

If you need to add another image from the Library to your group of images, left click the image you want to add and
hold the mouse button and drag it over your group of Images and release the mouse button. You will be given two
options, Add New Item and Add to Selected Item.

126 Chapter 3. Reference Manual



OpenLP Reference Manual, Release 3.0

If you click Add New Item your image will be separate from your group of images as another item at the bottom of the
Service. If you click Add to Selected Item your image will be added to your group of images.

3.8.11 Renaming a List Item

You can rename an item in the list to make it easier to understand. This is done by right clicking on item in your
service manager and left clicking Rename.

3.8.12 Adding a Service Note

You have the ability to leave yourself or the next projector person a service note. This is done by right clicking on an
item in your service manager and left clicking Notes.

You can type your note in the box and click Save. If you change your mind you can click Cancel. Your note will
appear as a yellow note on your item.

To view your note move your mouse cursor over the item in your service and you will see a popup with the information
you typed in your note.
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If you need to change your Note or delete it, open it again, delete your text and click Save

3.8.13 Creating a New Custom Slide

You have the ability to create a custom slide in the service manager by right clicking on the Song, Bible Verse or
Custom Slide then choosing Create new Custom Slide from the context menu. Follow the directions here Library to
create your new custom slide.

3.8.14 Using the Service Timer

The Service Timer is available for any media item with multiple slides. This includes Bible verses, Songs, or a group
of images. The Service Timer is accessed in the Live Controller Bar between the Live panes.

The time delay increment is in seconds. Use the up or down arrow on the right of the timer to change the number
of seconds or type in the number of seconds you want to use. This number determines how many seconds will lapse
before your media item will automatically change to the next slide.

Immediately to the left of the second counter is a down arrow. Clicking on this arrow will give you two options for the
use of the timer.

Play Slides in Loop: Selecting this option will continuously loop your slides from beginning to end, and back to the
beginning again. The slide loop will continue until you click the timer start and stop button again or move to the
next service item.

Play Slides to End: Selecting this option will display your slides through once and stop at the end.
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Timer start and stop: Click this button to start or stop the timer function. You can also
use the keyboard shortcut L to start and stop the continuous loop.

3.8.15 Using the Media Timer

Note: The media timer is only available when you are using System as your default player. Please check your
media configuration here: Settings → Configure OpenLP → Media. Configure your player using System with these
instructions. Media.

The media timer is used when you have a media file in your service manager and you would like it to start and/or stop
at a specified time.

After adding your media file to the Service you can mouseover your file and the popup will show you the play time
“Length” in hours, minutes and seconds.
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Right click on your media file and left click Start Time.

Item Start and Finish Time The start and stop time default to the beginning and end of the video.
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Change the hours, minutes and seconds to the times you want your video to begin and end. When you are finished
click Ok to save your changes or Cancel to leave the times as they were originally. When you display your media live
it will start and stop with the times you configured.

After your changes have been saved you can check your start and stop times by putting your mouse cursor over the
media file.
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3.8.16 Using the “Blank to” Control

On the Live Controller Bar in between the Live windows are three options to Blank your screen. Depending on how
narrow your slidecontroller is, the three options will be presented as a dropdown menu in the toolbar.

Or as three separate buttons in the toolbar.

Blank Screen: Choosing this option will blank your projector to black as if it were shut off. The shortcut for this
option is . (fullstop/period on your keyboard).
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Blank to Theme: Choosing this option will show your blank theme only, without lyrics or verses. If
you are blanking a song with an assigned theme it will blank to that theme. If no theme is assigned or you are
blanking a presentation or image, it will blank to the global theme. The shortcut for this option is T.

Show Desktop: Choosing this option will show your desktop wallpaper or a program that you have open
on the extended monitor or projector. You can seamlessly switch between one program and OpenLP by Blank
to Desktop. The shortcut for this option is D.

You can change or add to the keyboard shortcuts here Settings → Configure Shortcuts.

3.8.17 Linked Audio Control

You can stop or start the audio playing on your Linked Audio by using this button. This
button becomes available when you have linked an audio file to a song and it is in use.

To the right of the button a count down timer for the audio file is displayed to indicate the
play time remaining for the linked audio file. If you have multiple linked audio files, the play time remaining will only
be for the current playing linked audio file.
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By selecting the drop down menu between the button and the count down timer you can
jump to the next linked audio file for the song using Next Track or select the Tracks menu selection and jump to any
linked audio file in the song.

Linked audio files or groups of linked audio files can repeat when the last file finishes playing. To set linked audio
files to repeat, enable the Repeat track list in Configuring OpenLP on the General page.

Linked audio files can be set to start playing as soon as the first slide of the song is displayed. To enable the linked
audio files to start playing when the first slide is displayed, disable the Start background audio paused option in
Configuring OpenLP on the General page.

3.8.18 Saving the Service

Now that you created your service, tested it and are ready for your worship service, you will want to save your service
file. OpenLP will remind you to do this when you close the program or you can click the save button New, Open and
Saving the Service at the top of your service file. Choose the location you want to save your file and click Ok.

3.9 Print Service

OpenLP provides the ability to print the service order. This can be useful for a variety of reasons, such as giving the
printed service to your music team so they have the song order, or so pastors or speakers can have the flow of the
service.

To print your service go to File → Print Service or press Control + P.
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This will bring up a window with the service order for review and printing.

3.9. Print Service 135



OpenLP Reference Manual, Release 3.0

3.9.1 Toolbar

Print: This will print the service bringing up the system’s print options. Use this when you are
ready to print.

Options: This gives you a series of ways to customize the service order before printing. See the section on Options
for more information.

Copy: Copy the text of the preview window to your clipboard. You can then paste the text into
other documents or applications.

Copy HTML: Copy html code to your clipboard. You can then paste this in a text editor and save
as .html. This can then be used to post your service details on a website or anywhere an html document can be
used.

Zoom in: Zooms in on your preview.

Zoom out: Zooms out to make more of your preview visible.

Zoom to original: Restores the preview to its original size.
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3.9.2 Options

Title: Gives you the ability to change the title of the printed document.

Custom Footer Text: Add text to the footer of the printed document.

Other Options

Include slide text if available: Check this to include all the text from songs or scripture.

Add page break before each text item: If you have checked include slide text if available you can select this option
to put each text item (songs, custom slides, scripture) on a separate page.

Include service item notes: This option will include any notes you have added to the service items.

Include play length of media items: This option will print the length of audio and video items in the service.

3.9.3 Customizing with CSS (Advanced)

It is possible to customize the printed service using CSS. To do this go to Tools → Open Data Folder If you have a file
named servicePrint.css delete it.

Locate the folder in the Data Folder named serviceprint. If you do not have a serviceprint folder in your Data folder,
you will need to create a new folder named serviceprint in the Data folder.

Create a file named service_print.css in the serviceprint folder and paste the following into service_print.css then make
your changes to this file:
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/*
Edit this service_print.css file to customize the service order print.
Note, that not all CSS properties are supported.
Please see https://doc.qt.io/qt-5/stylesheet-reference.html for details
concerning the supported properties.

*/

.serviceTitle {
font-weight:600;
font-size:x-large;
color:black;

}

.item {
color:black;

}

.itemTitle {
font-weight:600;
font-size:large;

}

.itemText {}

.itemFooter {
font-size:8px;

}

.itemNotes {}

.itemNotesTitle {
font-weight:bold;
font-size:12px;

}

.itemNotesText {
font-size:11px;

}

.media {}

.mediaTitle {
font-weight:bold;
font-size:11px;

}

.mediaText {}

.imageList {}

.customNotes {
margin-top: 10px;

}

.customNotesTitle {
font-weight:bold;
font-size:11px;

(continues on next page)
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(continued from previous page)

}

.customNotesText {
font-size:11px;

}

.newPage {
page-break-before:always;

}

The HTML layout should look something like this:

<html>
<head>

<title>Service Order Sheet</title>
</head>
<body>

<h1 class="serviceTitle">Service Order Sheet</h1>
<div class="item">

<h2 class="itemTitle">
<img src=":/plugins/plugin_songs.png">
<span> Amazing Grace</span>

</h2>
<div class="itemText">
<p>Amazing grace how sweet the sound that saved a wretch like me<br>
I once was lost but now I'm found, was blind but now I see.</p>

</div>
<div class="itemText">
<p>Twas grace that taught my heart to fear, and grace my fears relieved<br>
How precious did that grace appear the hour I first believed!</p>

</div>
<div class="itemFooter">
John Newton<br>
1982 Jubilate Hymns Limited

</div>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>
<span class="itemNotesText">Song Notes<br>
More Notes</span>

</div>
</div>

<div class="item newPage">
<h2 class="itemTitle">

<img src=":/plugins/plugin_songs.png">
<span> And Can It Be</span>

</h2>
<div class="itemText">
<p>And can be that I should gain,<br>
an interest in my Savior's blood?<br>
Died He for me, who caused His pain?<br>
For me, who Him to death pursued?<br>
Amazing love, how can it be<br>
That thou my Lord should die for me?</p>

</div>
<div class="itemText">
<p>Amazing love, how can it be<br>

(continues on next page)
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(continued from previous page)

That thou my God should die for me?</p>
</div>
<div class="itemFooter">
Lindell Cooley<br>
Public Domain

</div>
</div>

<div class="item">
<h2 class="itemTitle">

<img src=":/plugins/plugin_media.png">
<span> Wildlife.wmv</span>

</h2>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>
<span class="itemNotesText">Movie Notes</span>

</div>
<div class="media">
<span class="mediaTitle">Playing time:</span>
<span class="mediaText">0:00:00</span>

</div>
</div>

<div class="item newPage">
<h2 class="itemTitle">

<img src=":/plugins/plugin_bibles.png">
<span> John 3:16-17 (ASV)</span>

</h2>
<div class="itemText">
<p><sup>3:16</sup> For God so loved the world, that he gave his only

→˓begotten Son, that whosoever believeth on him should not perish, but have eternal
→˓life.</p>

</div>
<div class="itemText">
<p><sup>3:17</sup> For God sent not the Son into the world to judge the

→˓world; but that the world should be saved through him.</p>
</div>
<div class="itemFooter">
ASV, Copyright, Permissions

</div>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>
<span class="itemNotesText">Bible reading notes</span>

</div>
</div>

<div class="item">
<h2 class="itemTitle">

<img src=":/plugins/plugin_images.png">
<span> Images</span>

</h2>
<ol class="imageList">
<li>Winter.jpg</li>
<li>Sunset.jpg</li>

</ol>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>

(continues on next page)
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(continued from previous page)

<span class="itemNotesText">Image notes</span>
</div>

</div>

<div class="item newPage">
<h2 class="itemTitle">

<img src=":/plugins/plugin_custom.png">
<span> Lord's Prayer Traditional</span>

</h2>
<div class="itemText">
<p>Our Father,<br>
who art in heaven,<br>
hallowed be thy name.<br>
Thy Kingdom come,<br>
thy will be done,<br>
on earth as it is in heaven</p>

</div>
<div class="itemText">
<p>Give us this day our daily bread.<br>
And forgive us our trespasses,<br>
as we forgive those<br>
who trespass against us.<br>
And lead us not into temptation,<br>
but deliver us from evil.<br>
For thine is the kingdom,<br>
the power and the glory,<br>
for ever and ever. Amen</p>

</div>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>
<span class="itemNotesText">Custom Item Notes</span>

</div>
</div>

<div class="item">
<h2 class="itemTitle">

<img src=":/plugins/plugin_presentations.png">
<span> Sermon Presentation.pptx</span>

</h2>
<div class="itemNotes">
<span class="itemNotesTitle">Notes:</span>
<span class="itemNotesText">Presentation notes</span>

</div>
</div>

<div class="customNotes">
<span class="customNotesTitle">Custom Service Notes:</span>
<span class="customNotesText">Custom Footer Text Goes here like this</span>

</div>
</body>
</html>

Edit the CSS file to produce the required style.

Note: Not all CSS properties are supported. See Qt5 CSS subset for more information.

Example 1: Item titles with notes on right hand side.
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This service_print.css assumes the slide text will not be included.:

.itemTitle {
font-weight:bold;
font-size:large;
margin: 0px;

}
.itemNotes {

margin-left: 300px;
margin-top: 0px;

}
.itemNotesTitle {

font-weight:bold;
}

Example 2: Bold Item Names and increase Font Size to 24 point for the Item Title and Item Text.

For this example, update the following sections of the original CSS file:

.itemTitle {
font-weight:bold;
font-size:24pt;
margin: 0px;

}
.itemText {

font-size:24pt;
}

Transfering with Your style changes for editing

After modifying the .css file, the copy button will not capture the output with the changes made to the .css file. The
Print function will print with the changes in the .css file and the Copy as HTML button will capture the output with
the changes made to the .css file.

If you need to edit the output of the service print window here is a workaround that will produce a copy of your .css
changes for use in your word processer.

1. Open the service print window.

2. Make any needed changes in the options menu.

3. Select the ‘Copy as HTML’ button.

4. Open a text editor.

5. Paste the copied text into the text editor.

6. Save the file from the text editor with the .html file extension.

7. Open the file you saved in your web browser.

8. Select and Copy the text in the web browser.

9. Open your word processor.

10. Paste the copied text into your word processor.

Note: If the first line in your word processor is not what is shown in your web browser, try a different web browser.
Some web browsers will not copy the formating for the first line of text in the browser window.
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3.10 Projector Manager

The Projector Manager allows you to remotely control a network-connected projector that conforms to the Japan
Business Machine and Information System Association (JBMIA) PJLink specification. Available in OpenLP v2.2.

3.10.1 Projector Configuration

The available projector options can be changed using the main settings menu by going to Settings -> Configure OpenLP
-> Projectors tab. See Projectors.

3.10.2 Projector Manager

The Projector Manager is the interface to controlling your projector(s). It is located on the bottom-right corner of
OpenLP just below the Theme Manager.

The icons on the Projector Manager tab will depend on projector entries as well as how many projectors are selected
at once.

A list of possible projector icons are:

New Projector: Choosing this option will open the “Create New Projector” dialog so you can enter a new projector
item.

Edit Projector: When you have selected a projector item, this option will open the “Edit Projector” dialog so you
can make changes to that projector item.

Select Projector Input: When you have selected a projector item and it is connected and power is ON, this
option will give you a dialog that allows you to select the video source the projector will use.
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Delete Projector: When you have selected a projector item, this option will allow you to delete the projector item
from the Projector manager list.

Projector Information: When you have selected a projector item and it is connected to
the projector, this option will give you an information box with extra information about the projector.

Connect to Projector: When you have selected a projector item, this option will allow you
to connect to the projector.

Connect to Multiple Projectors: When you have multiple projector items selected, this option will allow to to
connect to multiple projectors at once.

Disconnect from Projector: When you have a projector item selected, this option will al-
low you to disconnect from the projector.

Disconnect from Multiple Projectors: When you have multiple projector items selected, this option
will allow to disconnect from multiple projectors at once.

Power On Projector: When you have selected a projector item and it is connected, this option will allow you to
turn the projector to “Power ON”.

Power On Multiple Projectors: When you have selected multiple projector items and they are connected, this
option will allow you to turn the projectors to “Power ON”.

Power Off Projector: When you have selected a projector item and it is connected, this option will allow you to
turn the projector to “Power STANDBY”.

Power Off Multiple Projectors: When you have selected multiple projector items and they are connected, this
option will allow you to turn the projectors to “Power STANDBY”.
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Blank Projector Screen: When you have a projector item selected and it is powered ON,
this option will allow you to blank the projector screen so no video is shown.

Blank All Projector Screens: When you have multiple projector items selected and they
are powered ON, this option will allow you to blank the projector screens so no video is shown.

Show Projector Screen: When you have a projector item selected and it is powered ON,
this option will allow you to unblank the projector screen so video is shown.

Show All Projector Screens: When you have multiple projector items selected and they
are powered ON, this option will allow you to unblank the projector screens so video is shown.

3.10. Projector Manager 145



OpenLP Reference Manual, Release 3.0

3.10.3 Adding a Projector

To add a new projector, click on the Add New Projector icon on the Projector Manager tab bar. You will be given an
input dialog box like the below image.

The required information are “IP Address”, “Port Number”, and “Name” entries. The port number is already set with
the default PJLink port.

The “PIN” entry is only needed if the projector you are connecting to has the PJLink PIN set. Be careful, since most
projectors have a separate entry for the PJLink PIN, any other network PIN or password, as well as a separate entry
for any HTML access name/password settings (if the projector has HTML webpage access). The PIN setting here is
ONLY used if the projector has a “PJLink access code” or “PJLink PIN” setting.

For information on what the fields are, you can click on Help button for some information about what is expected for
each field.

Once you are done entering the new information, click on Save to save the entry and add it to the projector manager
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list. If you decide to not add a new entry, click the Cancel button to close the dialog without saving.

Congratulations, you now have your first projector entry in the list and ready for control.

When you have multiple projector entries selected, the projector manager toolbar will change to the following:
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Once you select a projector, the icons will also change based on the status of the projector.

3.10.4 View Projector Information

After you have a projector item added and it’s connected, you can view the current status of the projector by clicking on
the View Projector Information icon. You will see a pop-up box that looks similar to the following: (NOTE: Example
information only - the information you see will depend on the projector that you are connected to)
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3.10.5 Projector Status Icons

The icons next to the projector entry in the projector manager list give you a quick visual status of the projector.

The icons you will see for the projector are:

Projector is disconnected
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Attempting to connect to projector

There was an error connecting to projector

The projector power is OFF (Standby)

The projector is warming up

The projector is on

The projector is cooling down before power off (standby)
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The projector is reporting an error

3.10.6 Projector Menus

The projector menu items will vary depending on what the status is of the selected projector. The icons/options
available are the same as described above in the icon description section.

Initial Menu

When you first enter a projector or when you first start OpenLP, you will select from the following menu items:

Projector Connected in Standby Mode

Once the projector has been connected, and if the projector is not powered on, you get the below menu list:
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Projector Connected in Warmup Mode

Once the projector is in warming up, you will see the following menu:

Projector Connected and Power On

Once the projector is on, you will see the following menu:

Projector Connected and in Cooldown Mode

When the projector is cooling down, you will see the following menu:
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3.10.7 Video Source Options

The video source options allow you to tell the projector to change it’s video source input, as well as allowing you to
personalize what the video settings options.

Video Source Input Select Options

If you want to change the video source the projector uses, click on the Select Source option, then select from the
pop-up window which video source you want to use. You can access the Select Source option from either the projector
manager toolbar or from the right-click pop-up menu.

You have an option of setting two different styles for the video source window. The default option is all entries on one
radio button dialog. The other option is to have the selections grouped by type. This option is available in the Settings
-> Configure OpenLP -> Projectors tab under the “Source Select dialog interface” option.

NOTE: These images are examples only - what options you will have will vary depending on the projector you have.
These images show the default PJLink text.

Video Source Input Edit Options

When you want to customize how the video source select text looks, click on the Edit Input Source icon in the right-
click menu. This will bring up the source edit dialog box.

NOTE: These images are examples only - what options you will have will vary depending on the projector you have.
These images show the default PJLink text.
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Once you are satisfied, you can click on the OK button to save the changes, or click on the Cancel button to dis-
card these changes and continue to use the previously saved user-defined text (or the PJLink defaults if you have no
previously saved user-defined text).

If you don’t like the changes, the Reset button will reset the text back to the previously saved text (or PJLink defaults
if you have no previously saved user-defined text) and allow you to continue editing.

If you _really_ don’t like the text, you can select the Discard button and remove all entries from the database. WARN-
ING: This will delete _all_ of the user-defined entries for this projector in the database and return them to the PJLink
defaults.

3.11 Plugin List

OpenLP has many plugins you can activate.

To see which plugins are enabled select Settings → Manage Plugins or Alt+F7
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3.11.1 Plugin Details

The left side shows you the list of plugins. Click on a plugin to check its status.

Status Shows if your plugin is Active or Inactive. Click the box to change the status and click OK to save your
selection.

About Describes the use of the plugin.

For a brief description of what each plugin does, please see below.

Songs Plugin The songs plugin provides the ability to display and manage songs.

Bible Plugin The Bible plugin provides the ability to display Bible verses from different sources during the service.

Presentation Plugin The presentation plugin provides the ability to show presentations using a number of different
programs. The choice of available presentation programs is available to the user in a drop down box.

Image Plugin The image plugin provides displaying of images. One of the distinguishing features of this plugin
is the ability to group a number of images together in the service manager, making the displaying of multiple
images easier. This plugin can also make use of OpenLP’s “timed looping” feature to create a slide show that
runs automatically. In addition to this, images from the plugin can be used to override the current theme’s
background, which renders text-based items like songs with the selected image as a background instead of the
background provided by the theme. See the section on Adding a Group of Images.

Media Plugin The media plugin provides playback of audio and video.

Custom Slide Plugin The custom slide plugin provides the ability to set up custom text slides that can be displayed
on the screen the same way songs are. This plugin provides greater freedom over the songs plugin.
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SongUsage Plugin This plugin tracks the usage of songs in services.

Alerts Plugin The alert plugin controls the displaying of alerts on the display screen. See Alert for more informa-
tion

PlanningCenter Plugin The planningcenter plugin provides an interface to import service plans from the Planning
Center Online v2 API.

3.12 Formatting Tags

OpenLP has the ability to add additional formatting to text in songs and custom slides through the use of Formatting
Tags. Formatting Tags provide a shortcut to use HTML and CSS to format text.

Formatting Tags consist of two parts, a starting and an ending tag, each tag consisting of a brace, tag identifier, brace.

Note: HTML or CSS cannnot be directly entered into OpenLP. They must be defined through the use of Formatting
Tags

3.12.1 Using a Formatting Tag

Formatting Tags can be inserted by typing the tag into the text that is being edited or by using the mouse to select and
insert the tags. Formatting Tags can not span across page breaks. If a tag begins with text on one side of a page break
it cannot stretch across the break. Instead, two sets of tags will need to be used, one set on each side of the break.

Adding Formatting Tags Using Text

To use Formatting Tags surround the text with a starting tag {} followed by the text to be formatted. End the text to be
formatted with an ending tag {/}.

Example of Use

To make a section of text bold you would do the following in a custom slide or song:

Amazing grace how {st}sweet{/st} the sound.

This will yield the text as:

Amazing grace how sweet the sound.

Adding a Formatting Tag Using The Mouse

Formatting Tags can be inserted by selecting the text you wish to format. Right click on the text and select Formatting
Tags followed by selecting the desired formatting.
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Example of Use

Select the song or custom slide to edit. Next, highlight the text that you want to be formatted.

Right click on the selected text and select Formatting Tags followed by selecting the desired formatting for the selected
text.
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The formatting tags should now be inserted.
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Included Formatting Tags

The following tags are included with OpenLP

• {r} red text

• {b} black text

• {bl} blue text

• {y} yellow text

• {g} green text

• {pk} pink text

• {o} orange text

• {pp} purple text

• {w} white text

• {su) superscript text

• {sb} subscript text

• {p} paragraph

• {st} bold

• {it} italics

• {u} underline

• {br} break

3.12.2 Configuring Formatting Tags

To add new Formatting Tags go to Settings → Configure Formatting Tags
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Click the New button to add new Formatting Tags. Enter the description of the Formatting Tags followed by the tag.
The tag must be unique. You do not need to put the in braces {} here, only when using the tag. Finally, enter in the
HTML or CSS for the tag and click Save to complete adding new Formatting Tags.

To delete Formatting Tags that you have entered click on the Formatting Tags from the list and click Delete.

Note: if a tag is deleted that is in use in a song or custom slide the slide will display the tags {} without any formatting.
The deleted tags will need to be manually deleted from the songs or custom slides.

3.12.3 Additional Useful Tags to Add

The Formatting Tags included when you installed OpenLP provide many of the commonly used formating Tags. The
following are Formatting Tags that are used by some of the user community and may be of use to you.

The alignment Tags can be used to override the Theme formating. A common use is to Center the Title of a song when
the Theme is left justified.

The Font size up and down Tags can be used to make the Theme Font size larger or smaller for the text between the
tags. Both Tags can be combined to provide multiple size changes.

The Font size 20pt Tag sets the font size to a specific size. The size ‘20pt’ is not an exact copy of what you would get
in a word processor, but will be comperable in size.

The Font name Tags, Arial and Times New Roman, will change the font used for the text enclosed by the Tags. The
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Font name Tags can be combined with Color or Formating Tags to create easily destiguishable differences on the
screen. One use could be for responsive readings.

The Paragraph with hanging text is used to indent the lines of Text after the first line of text in a paragraph.

The Column Left and Column Right Tags can be used to create two columns of text, each left justified.

De-
scrip-
tion

Tag Start HTML End
HTML

Align
Left

al <div align="left"> </
div>

Align
Center

ac <div align="center"> </
div>

Align
Right

ar <div align="right"> </
div>

Big font
size

fu <big> </
big>

Small
font size

fd <small> </
small>

Font size
20pt

f20 <span style="font-size: 20pt"> </
span>

Arial ar-
ial

<span style="font-family:arial;"> </
span>

Times
New
Roman

times<span style="font-family:times new roman;"> </
span>

Para-
graph
with
hanging
test

phg <div style=" padding-left: 2em;text-indent: -0.5em;
adding-left: 2em; padding-bottom:0.1em; margin:4em;
float: left; ">

</
div>

Column
left

cl <div style="position:absolute; margin-left:0%"> </
div>

Column
right

cr <div style="position:absolute; margin-left:50%"> </
div>

3.13 Customize Shortcuts

OpenLP gives you the ability to use keyboard shortcuts either by changing the default primary ones already assigned
or by adding an alternate shortcut that will work alongside the primary shortcut.

To Configure Shortcuts go to Settings → Configure Shortcuts

The image below shows a partial list of shortcuts you can customize.
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Across the top of the list are Action, Shortcut and Alternate.

Action: This is the name of the of the shortcut you can change. It could be part of the menu selection or a toolbar
item.

Shortcut: This is the keyboard shortcut assigned to the action beside it.

Alternate: This is the alternate shortcut you can assign to the action. Each Action can have two different shortcuts
assigned to it.
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3.13.1 Changing a Shortcut

Capture shortcut: To change a shortcut click on an Action in the list that you would like to modify. Click on the

left to add or modify the default shortcut and the right to modify or add an alternate shortcut. After you
click on one of the boxes you can type in the key or combination of keys you want to use for your shortcut.

Restore the default shortcut of this action: If you are not happy with your shortcut se-

lection you can restore it to its default value by clicking the icon next to the shortcut.
This will set the shortcut to its original state.

If there is a shortcut you want to remove from an action and not assign another one you can click on twice. This
will remove the shortcut.

All Actions that you click on will show either Default or Custom.

If you change or add any shortcut the option button for Custom will be selected. Clicking the Default option button

will restore the original shortcut. You can also click to change it back to default.

If you don’t like any of your changes or find that you want to return the shortcuts back to their original settings, click
Restore Defaults.

When you are done making your changes click OK. If you don’t want to save any of your changes click Cancel
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3.14 Themes

The Theme Manager is where you can set backgrounds, fonts, and colors to the style you desire. From the theme
manager you can create a new theme, Edit a theme, Delete a theme, Import a theme, and Export a theme.

3.14.1 Creating New Themes

Create a new theme: This will bring up the Theme Wizard
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Click Next. You have 4 choices in the drop down menu for Background type: Solid Color, Gradient, Image or
Transparent.
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Solid color: Select solid color and click on the black button next to Color. You have the option of choosing among
the colors you see or entering your own.
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Gradient: Choose the two colors, Starting color and Ending color that you want to fade together and the Gradient
drop down will let you determine the directions of the fade.
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Image: You have the ability to use an image for your background. OpenLP accepts a variety of image types. JPG is
the most common format of images but can cause previews to be slow. If you experience this you may want to
convert your image to PNG as it previews quicker than other formats.
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Background color: Choose the color that will appear on the borders if your image is smaller than your projector
display setting.

Image: Click to find and select your image.

Note: When possible, try to use the same size image as your projector is displaying unless you want a background
color for a border.

Transparent: Using the transparent theme will use whatever wallpaper or background color that your desktop is
using for the theme background.
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When finished with your selection for background, click the Next button.

Main Area Font Details

This is the area where you will select and define your font characteristics for the Display text.
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Font: Choose the font you would like to use from the drop down.

Color: Choose the color of your font.

Size: The size of your font determines how many lines are shown per slide. As you change the font size, the lines per
slide will change.

Line Spacing: This setting determines how much space you want between lines. This setting will also change the
lines per slide.

Outline: If you desire an outline around your font, select the Outline box, choose your color and size of the outline.

Shadow: If you desire a shadow around your font, select the Shadow box and choose your color and size of the
shadow.

Bold Display: Select the box for Bold font

Italic Display: Select the box for Italic font

When you are finished selecting your font details click the Next button.
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Footer Area Font Details

This page determines the Font, Font Color, and size of the font for the footer. The footer is where the Title of the song,
Author or Authors, Copyright and CCLI License are displayed.

When you are finished setting your footer font details, click Next.
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Text Formatting Details

This page determines the alignment of the text on your slide and the transition from one slide to the next.

Horizontal Align: This moves the text to the Left, Right, Center or Justify on the screen.

Note: Text is only justified when the text does not fit on one line, (only when a line is wrapped).

Vertical Align: This moves the text to the Top, Middle or Bottom of the screen.

Transitions: When this box is selected, switching slides will fade out from one and fade in to the next. When the box
is not selected, slide changing will be instant.

When you are finished setting your Text Formatting Details, click Next.
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Output Area Locations

This page gives you the ability to change the position of your main area and footer area to a specific location on the
screen using the X and Y positions or a specific size using width and height. (e.g. if you have a theme image with a
border around it and do not want your lyrics to be displayed over top of the border or if you do not want your footer
displayed on the bottom left, you can make the adjustments here).

To view your main and footer layout positions click Layout Preview. The blue outlined area shows the position of the
main window and the red outlined area is the position of the footer area. To go back to the previous window click OK
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To change the default locations or sizes of the main and footer area toggle off the Use default location on the main
area or footer area by clicking on the checkmark. This will unlock the X and Y positions and the width and height.
You will now be able to change the settings.
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Click Layout Preview to view the changes made.
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When you are satisfied with the settings of your Output Area Locations, click Next.
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Save and Preview

Theme Name: Enter your theme name here.

Preview: The Preview shows the choices you made when setting up the previous pages plus, shows all the edit effects
possible so you can see what the impact is on all possible font colors and characteristics.

When you are satisfied with your selections, click Finish. If you want to make a change, use the Back button.
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3.14.2 Editing Themes

Now that you created your theme and you display it on the projector and there is something you don’t like, you can

easily Edit your theme either by clicking the Theme Edit Button or by right-clicking your
theme and selecting the appropriate action.

3.14.3 Deleting Themes

Delete a theme: Delete a selected theme or you can right-click your theme and select
Delete.

Note: You cannot delete the theme currently selected as global or default.

3.14.4 Exporting Themes

If you would like to transfer a theme from one computer to another, click on the theme you want to export, click

and choose the folder you want to save your theme in and click OK.
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3.14.5 Importing Themes

To import a theme that has been previously exported, click the import button and select the
folder and the theme file, and click OK. Your imported theme will be entered in the Theme Manager. Import Theme
will also handle version 1 Exports. You will need to check your imported theme since many of the values will have
been defaulted.

3.14.6 Rename Theme

If you created a theme and want to change the name of it, right-click your theme and click Rename theme and enter
the new name.

Note: You cannot rename the theme currently selected as global or default.

3.14.7 Copy Theme

Now that you created a theme with all the attributes you like, you can right-click the theme, click on Copy theme,
choose your new name and click OK. You now have a duplicate of your first theme that you can edit the way you want.

3.14.8 Set as Global default

If you right-click your theme, you have the option to set the theme as Global default. This option is covered in greater
detail under Configuring OpenLP.

3.15 Songs

This section describes the use of the various converters built into OpenLP for managing and importing song files from
other formats.

3.15.1 Song Importer

If you are using an earlier version of OpenLP or, come from another software package, you may be able to convert
your existing database to work in OpenLP. OpenLP can import songs from the following sources:

• OpenLyrics or OpenLP 2 Exported Song

• Generic Documents/Presentations (Requires LibreOffice)

• CCLI SongSelect Files

• DreamBeam Song Files

• EasySlides XML File
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• EasyWorship 2009 Song Database

• EasyWorship 2009 Service File

• Foilpresenter Song Files

• LiveWorship Database Dump

• LyriX (Exported TXT-files)

• MediaShout Database (Windows only)

• PowerPraise Song Files’

• PowerSong 1.0

• PresentationManager Song Files

• ProPresenter 4 Song Files

• SongBeamer Files

• SongPro (Export File)

• SongShow Plus Song Files

• Songs Of Fellowship Song Files (Requires LibreOffice)

• SundayPlus Song Files

• VideoPsalm Files

• Words Of Worship Song Files

• Worship Assistant (Export CSV)

• WorshipCenter Pro Song Files (Windows only)

• ZionWorx (Converted CSV)

To access the Song Importer click File → Import → Song. You will see the Song Importer window, then click Next.
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After choosing Next you can select from the various types of software that OpenLP will convert songs from.
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Click on the file folder icon to choose the file of the song database you want to import. See the following sections for
information on some of the different formats that OpenLP will import.

Importing from OpenLyrics or OpenLP 2 Exported Song

OpenLyrics is an open format for song lyrics defined at openlyrics.org, and is the format the OpenLP can export songs
to, see Exporting Songs.

To import press Add Files. . . and select the OpenLyrics files. Then press Next to import the files.
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Importing from EasyWorship Song Database

OpenLP can import the song database from EasyWorship 2007 and 2009. To import songs from EasyWorship’s
database you must find and select the file Songs.DB. You will normally find the file in C:\Users\Public\
Documents\Softouch\EasyWorship\Default\Databases\Data\.

OpenLP will import all the songs it finds in the database.

Importing from OpenSong

Converting from OpenSong, you will need to locate your songs database. In the later versions of OpenSong you are
asked to define the location of this. The songs will be located in a folder named Songs. This folder will contain files
with all your songs in them, without a file extension (file.xxx). When you have located this folder you will need to
select the songs from the folder.

On most operating systems, to select all the songs, first select the first song in the list, press the shift key, and select
the last song in the list. After this press Next and you will see that your import has been successful.

Press Finish and OpenLP will be ready to use your songs that you imported from OpenSong.
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Importing from CCLI Song Select

To import from CCLI Song Select you must be a CCLI Subscriber and also a subscriber of the Song Select service.
For more information go to the CCLI website.

The first step for importing from CCLI Song Select is to log into your account. Once you have logged in search for
your desired song. For this example we will be searching for and adding the song “Amazing Grace”.

You will be presented with the results of your search. Click the LYRICS button and it will take you to the lyrics page
displaying the lyrics and copyright information for your song.
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Next, hover the mouse over the Download button from the upper right corner and choose either the .txt or .usr file.
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You will be asked to choose a download location if your browser does not automatically select one for you. Select the
downloaded file from the OpenLP import window and then click Next. When import is finished, you will find your
song in the Library.

Note: Most operating systems allow you to select multiple songs for import by selecting the first item in the list and
then holding the Shift and selecting the last item in the list or holding the Ctrl and selecting the files individually.
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Press Finish and OpenLP will be ready to use your songs imported from CCLI SongSelect.

Importing from ZionWorx

ZionWorx stores your songs in a proprietary database format which OpenLP is unable to access directly. You will
first need to convert it to a CSV text file, which OpenLP and other tools (such as spreadsheet applications) are able to
access. This can be achieved via a demo third-party utility called “TurboDB for VCL 6” for database version 3.8 or a
free third-party utility called “TurboDB Data Exchange” for database version 2.5/2.6.

First, locate your ZionWorx songs database. ZionWorx lets you define the location in File → Preferences. The
database folder will contain a collection of files. If you find Song.tbdbt your database is version 3.8. If you find
files such as Data.tdbd and MainTable.dat your database is version 2.5/2.6.

Default location for ZionWorx 3.8 on Windows 10:

C:\ProgramData\Jubilate Software\ZionWorx\Data

Default location for ZionWorx 2.6 on Windows XP:

C:\Documents and Settings\All Users\ZionWorx\2.6\Data
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Default location for ZionWorx 2.6 on Windows Vista or later:

C:\ProgramData\ZionWorx\2.6\Data

Version 3.8

Download TurboDB for VCL 6 from dataWeb. The install will be a windows installer file.

Create a Restore Point before installing TurboDB for VLC 6.

Double Click the TurboDB for VCL 6 file you downloaded and follow the prompts to install the programs. Use all the
default options for any questions you may be asked. Once the installation is complete open TurboDB Viewer from the
start menu.

Open the database using the Database → Open → Database. . . dropdown menu.

Use the File Selection window to select any of the files in your database directory. When the File Selection window
closes you will see the tables in the database displayed near the top of the TurboDB Viewer window. Select the SQL
tab just above the table names.
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Cut and Paste the SQL command below into the SQL tab.:

Select SongID,
Title,
AltTitle as "Title2",
Lyrics,
WordsBy+' '+MusicBy as "Writer",
Copyright,
PublicDomain as "Keywords",
DefaultStyle
from Song

With the SQL command entered into the SQL tab, select the green Run arrow to run the SQL statement.

When the SQL command has been processed the lower part of the window will contain the songs from the ZionWorx
database in the format that OpenLP can import. To export the songs to a file, select Tools → Export Records. . .

The TurboDB Batch Move Wizard will open to guide you through the export process. Select the . . . button and use the
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file selection window to navigate to a directory and create a name for the output file.

Use the filetype dropdown to select Text File as the file type of the export file.
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Once the filename and the filetype have been input press the Continue button.
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The Wizard will update and allow you to set the options for the export. Verify that the checkbox for The First row of
the file holds the fieldnames is checked. Verify that the Quoted Character is the double quote. Verify that the Fields
are separated by option is a comma. Then press the Continue button.
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When the progress completes you will see a completion message in the window and can select the Close button to
close the Batch Move Wizard.
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Please see Importing the CSV file below to import your songs.

Version 2.5/2.6:

Download TurboDB Data Exchange from dataWeb. The utility will be downloaded as an archive file:

Windows:

Open tdbdataX.zip and copy TdbDataX.exe into your ZionWorx database folder.

Press the keyboard combination Windows key + R to open the Run window.

Type cmd and click OK.

In the command prompt window that opens, type these commands (replacing
database-folder with your actual location), followed by Enter:

cd "database-folder"
tdbdatax MainTable.dat songstable.csv -fsdf -s, -qd

Linux:

Right click on tdbdatax.tar.gz and select Unpack or Extract. Then right click on
tdbdatax, select Properties, and make sure the executable option is checked.

Alternatively, in the terminal:
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tar xvzf tdbdatax.tar.gz
chmod u+x tdbdatax

Copy tdbdatax into your ZionWorx database folder.

Finally, open a terminal and cd to your ZionWorx database folder. Type this command and
press Enter:

./tdbdatax MainTable.dat songstable.csv -fsdf -s, -qd

You should see some feedback indicating success, such as:

Batch move has moved 408 records.

Importing the CSV file:

Your ZionWorx songs database has now been converted to a CSV text file. Run the Song Importer in OpenLP, select
ZionWorx (CSV), and locate the songstable.csv file you just created.

After clicking Next your import will be complete.
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Importing from LiveWorship

LiveWorship stores your songs in a proprietary database format which OpenLP is unable to access directly. You will
first need to convert it to an XML file file, which OpenLP will then be able to import. This can be done by downloading
Valentina Studio from Valentina DB. It is available for both Windows, Linux and macOS. The free version is enough
for what is needed to convert the song database. After installing Valentina Studio, open it.

The first time you open Valentina Studio you can enter register and get a serial number (it is available for free) to get
full access to Valentina Studio. You can also just cancel or skip this step, which will open Valentina Studio in demo
mode, meaning it will only work for 10 minutes at a time, but that is enough for converting a database.

Open File → Open Database and find the song database file you wish to convert. It will usually end with .
vdb, on Windows it will usually be located in C:Users<username>AppDataLocalVirtualStoreProgram
Files (x86)LiveWorshipMedia Library This will open the song database. To dump the database content
to XML, open File → Open Database. Select XML as Output Format and Structure And Records for Dump Content.
Select Dump Destination and keep the encoding as UTF-8 and save the dump.

Your LiveWorship songs database has now been converted to an XML file. Run the Song Importer in OpenLP, select
LiveWorship Database Dump, and locate the XML file you just created.

After clicking Next your import will be complete.

3.15.2 Creating or Editing a Song Slide

When you want to create a new song slide or, once you have a song imported, you want to edit and rearrange the Title
& Lyrics, Author, Topics & Song Book, assign a Theme, or edit Copyright Info & Comments, you will do this through
the Song Editor.

Edit: To edit an existing song you can either click on a song in the Library and then click the button to Edit the
selected song or right click a song from either the Library or additionally from the Service and click Edit item.
If you are adding a new song click Add a new Song in the Library.
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Title: This is where you would name the song or edit a song name.

Note: Anything typed in the title name between these brackets <> will not be displayed in the screen title. See Clone
below.

Alternate title: Alternate Title was for songs with two names “Lord the Light” - “Shine Jesus Shine”. You can also
add a name in this box that will bring up the song in Titles search. Example: You could use an alternate title
of “hymn” on all your hymn song titles for grouping. When you search “hymn” it will show all the hymns that
have “hymn” for the Alternate title.

Lyrics: The Lyrics window shows all lyrics imported or added. On the left side of the lyrics you will see a capital
letter followed by a number. A V1 would represent verse 1, C1 would be Chorus 1. You will use these letters
and numbers for the order to display the lyrics.

Verse Order: After you entered or edited your song, you will want OpenLP to display the verses in the correct order
you want them displayed. On the left side of your lyrics you will see C1, V1, V2 etc. the way they were imported
or added. To put your lyrics in the correct order is as simple as typing in the Verse order box at the bottom, the
correct order you want them displayed, with only a blank space in between each entry. The correct format will
look like this: V1 C1 V2 C1 V3 C1. If you forget to put a space in between the order, or if you do not have the
corresponding verse number, OpenLP will politely tell you with a pop-up error message what is wrong so you
can correct your mistake and save it. Verse order is optional and if left blank the verses will display in the order
seen in Lyrics.
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If you forgot to add a verse or intentionally left a verse out of your order you will see the notification at the bottom left
of the window saying “Warning: Not all of the verses are in use.”

If you have not entered a verse order, you will see a notification in the same place saying “Warning: You have not
entered a verse order.”

Clone: OpenLP gives you the ability to clone a song. This could be useful if you use a different version of the song
with slightly different lyrics. Instead of typing in all the lyrics again, you can clone it which makes an identical
copy of the original song.

To Clone a song right-click on the song you would like to duplicate and left- click Clone.
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After you click Clone you will see the copy of the song with <copy> in the title.

Note: Anything typed in the title name between these brackets <> will not be displayed in the screen title.

Adding or Editing the Lyrics

Add: To Add a new verse, click on Add. The main window is where you will type your lyrics. OpenLP is packaged
with a spell checker for most languages. If you misspell a word it will be underlined. Right click the underlined
word and left click Spelling Suggestions or you can ignore it and continue typing. You also have the ability
to format the font using Formatting Tags. Highlight the word/words you want to format and right click the
highlight. Left click Formatting Tags and choose the format you want to apply to the font and the format tags
will be entered with your lyrics. These tags are not visible when displayed. To remove the format, delete the tag
on each end of the word or sentence.

Edit: To edit an existing verse, click on the verse you wish to Edit then click on Edit, make your changes and click
Save.

Edit All: To edit the whole song at once, click on Edit All.

Delete: To delete a verse, click on the verse you want to delete and it will highlight, click on the Delete button and it
will be deleted.

Warning: Once you click the Delete button, you will not be asked again, it will be deleted immediately.
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Verse type: Select one of seven ways to classify your lyrics. Verse, Chorus, Bridge, Pre-Chorus, Intro, Ending, Other.

Optional Split: Inserts an optional split into the verse. An optional split is used by OpenLP to improve splitting
verses when presenting on a screen where there is not room for the entire verse on one screen. If an optional
split exists, OpenLP will use it when splitting the verse, otherwise it will simply split the verse when reaching
the end of the screen.

If you have more than one verse, you would number them Verse 1, 2, 3 as needed. If you find the verse has too many
lines for your screen, you can edit and shorten the verse and Add another slide.
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Authors, Topics & Song Book

Once your Title & Lyrics are added or edited the way you want them you must add or enter the author or authors of
the song. OpenLP requires all songs to have an author entered. You can add a blank space for the author name.

Authors: Click the drop down arrow to view all authors or start typing a name in the box and a list will appear. If the
authors name has not been added, type the authors name in the box and click Add to Song. The authors name
will appear below and will also be added to your database. If you accidentally add the wrong author you can
click on the authors name and click Remove.

Manage Authors, Topics, Song Books: Clicking this button will bring up your complete list of authors.
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Add: Clicking the Add button will bring up a box where you will add the Authors First name, Last name and Display
name. Click Save when you are finished.

Edit: The Edit button will bring up window where you can edit the info that is already there.

Delete: The Delete button will remove the author you have highlighted.
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Note: You cannot delete an author that is assigned to a song. Authors names are displayed in the footer.

Theme, Copyright Info & Comments

You can assign a Themes to a song, enter the Copyright information and add the CCLI number to the song. If you
imported a song from SongSelect this information will usually be entered.

Theme: Click the drop down arrow to display your list of themes or start typing a theme name in the box and the list
will appear. You can also create a new theme by clicking the New Theme button.

Copyright information: Add or edit the copyright information in this box. If you would like to use the © symbol
click © button. This information is displayed in the footer.

CCLI number: Enter the CCLI number in this box.

Note: This is the CCLI number of the song, not your contract number. This number is not displayed in the footer.

Comments: You can add comments in this box. This information is not displayed in the footer.
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Linked Audio

OpenLP gives you the ability to play an audio file or multiple audio files when the song is displayed live.

Add File(s): Add an audio file from a folder on your computer by clicking Add File(s).

Add Media: Add an audio file that is already in the Library by clicking Add Media.

Remove: Click on a file you want to remove and click Remove.

Remove All: Click on Remove All to remove all audio files linked to the song.

If you added multiple audio files, they will play in the order listed. You can change their position in the order by
clicking on an audio file and using the arrows.

Move selection up one position.

Move selection down one position.

When you are done, click Save to save your choices. You can click Cancel at anytime if you change your mind.

This button will appear in the Linked Audio Control when an audio file is being played with
a song. You can stop or start the audio playing by using this button.
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To the right of the button a count down timer for the audio file is displayed to indicate the
play time remaining for the linked audio file. If you have multiple linked audio files, the play time remaining will only
be for the current playing linked audio file.

By selecting the drop down menu between the button and the count down timer you can
jump to the next linked audio file for the song using Next Track or select the Tracks menu selection and jump to any
linked audio file in the song.

Linked audio files or groups of linked audio files can repeat when the last file finishes playing. To set linked audio
files to repeat, enable the Repeat track list in Configuring OpenLP on the General page.

Linked audio files can be set to start playing as soon as the first slide of the song is displayed. To enable the linked
audio files to start playing when the first slide is displayed, disable the Start background audio paused option in
Configuring OpenLP on the General page.
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3.16 Bibles

This section describes the use of the various converters built into OpenLP for managing and importing Bibles from
other formats.

3.16.1 Bible Import Wizard

If you are using an earlier version of OpenLP or, come from another software package, you may be able to convert
your existing database to work in OpenLP 2.0. To access the Bible Importer File → Import → Bible. You may also

enter the Bible Importer by clicking the Import Icon.

Click on the Import Bibles icon to start the Bible import wizard.

You will see the Bible Importer window, click Next.
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After clicking Next you can select from the various types of software that OpenLP will convert Bibles from. Click on
the file folder icon to choose the file(s) of the Bible database you want to import. See the sections below for more
information on the different formats that OpenLP will import. Click Next to continue.
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After selecting your file(s), you’ll be asked to fill in the details of the Bible you are importing. Remember to check what
information you need to display for your Bible’s translation, as some of them have strict rules around the copyright
notice. Click Next to continue.

Note: You can use one blank space using the space bar in the copyright field to continue if you do not have or need
copyright information.
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After entering the license details, OpenLP will start to import your Bible. It may take some time to import your Bible
so please be patient.
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When the import has finished click Finish and you should be ready to use your Bible in OpenLP.

Importing OSIS Bibles

Importing OSIS files is very simple. Select OSIS as your import source, select your OSIS Bible file and continue the
import process.
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About OSIS Formatted Bibles

The OSIS XML standard was designed to provide a common format for distribution of electronic Bibles. More
information can be found out at the Bible Technologies website.

If you have any software installed that is part of the Sword Project it can be easily converted.

You can use the commands below convert Bibles from that software to OSIS format.

The following commands are used in all platforms and the commands are case sensitive across all platforms. To
convert a Bible using the command prompt in Windows or a terminal in Linux or macOS you would type:

mod2osis biblename > biblename.osis

For example: if I wanted to convert a King James Version Bible I would type something similar to this:

mod2osis KJV > kjv.osis

You may also wish to dictate a file location for the conversion to place the osis file for example:

mod2osis KJV > /home/user/bibles/kjv.osis
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Importing OpenSong Bibles

Converting from OpenSong you will need to locate your Bibles database. In the later versions of OpenSong you are
asked to define the location of this. The songs will be located in a folder named Bibles. This folder should contain
files with all your Bibles in them without a file extension. (file.xmms). When you have located this folder you will
need to select the Bible from the folder.

You may also import downloaded Bibles from OpenSongs webpage (scroll down to find bibles). The process is the
same, except you will need to extract the Bible from a zip file. This is usually done by right clicking on the downloaded
file and select Extract or Extract Here. Note that some of the bibles on OpenSongs webpage are actually in the Zefania
format, which OpenLP can also import, see Importing Zefania Bibles.

After selecting the OpenSong Bibles you want to import, follow the rest of the import process. When the import has
finished you should be ready to use your OpenSong Bibles.
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Importing Web Download Bibles

OpenLP provides a Web Download method to import Bibles when you do not have a locally installed Bible available.
The Web Download method registers the Bible in OpenLP like the other Bibles only it downloads the verses as you
need them.

Warning: This import requires an internet connection when installing and when searching for verses and is not
meant to be used as your sole source for Bibles, but rather as another option.

To use the web download feature select web download from the import wizard.

First click Download bible list to download a list of available bibles.
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This will take a few moments depending on your internet connection and load on the servers.
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When the download is complete you can select from 3 different sources to download from: Crosswalk, BibleServer
and BibleGateway. From each source there are many Bible translations available, so there is a good chance that you
will find what you need.

You can also select a proxy server if needed from the Proxy Server tab. Your network administrator will know if this
is necessary. In most cases this will not be needed.
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After selecting your download location and the Bible you wish to use, click Next to continue the import process. When
your import is completed you should now be ready to use the web Bible.

Importing CSV formatted Bibles

If you have a Bible in .csv format OpenLP can import it. If you wish to create a bible in the CSV format yourself the
format is documented in the OpenLP API documentation.

CSV Bibles will consist of two files a books file and a verse file. Select CSV from the list of Bible types to import.

You are now ready to select your .csv files. You will need to select both your books and verse file location.
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After you have selected the file locations you can continue with the import process. Once it is complete you should be
ready to use your imported CSV Bible.

Importing Zefania Bibles

The Zefania project has many Bibles available from their website. Find the Bible you would like to import and
download the file. The downloaded file is a zip-file from which the Bible must be extracted. This is usually done by
right clicking on the downloaded file and select Extract or Extract Here.
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You can now simply select the extracted file for import and click Next to continue the import process. When your
import is completed you should now be ready to use the imported Zefania Bible.

3.16.2 Edit Bible Data

Some information about a Bible can be edited. What can be edited is dependent on the type of bible.

Select the Bible you want to edit then select the Bible Edit icon to edit the Bible informtion.

On the Meta Data tab you can update the Bible Version name, Copyright information and the Permissions for the
Bible.

You can also select the Book Name Language. Choosing Global Settings, the defualt setting, will display the Book
Names of the Bible in the Language set by the Operating System Language. You can change this setting by using the
dropdown to select a different option.

When you have made your changes you can select the Save button to save your changes, select the Cancel button to
discard your changes or select the Custom Book Names tab to continue editing.
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Selecting the Custom Book Names tab will allow you to update the book names that will be displayed.

Warning: Please note that when using a Web Bible you can not change the book names.

When you have made your changes you can select the Save button to save your changes, select the Cancel button to
discard your changes or select the Meta Data tab to continue editing.
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3.16.3 Delete a Bible

You can remove a Bible from OpenLP.

Danger: The only recovery from deleting a Bible is to reimport the Bible using the Wizard or copy the files from
a Backup of the Data directory.

Select the Bible version on either the Quick or the Advanced tab and click on the Delete
icon to delete a Bible. You will be asked to confirm you want to delete the Bible. Click on Yes to delete the Bible or
click No to cancel.

3.16.4 Preview Bible Verses

To Preview the selected verses in the left Preview panes, select the Send to Preview icon.

3.16.5 Send Scriptures to Live Display

To Preview the selected verses in the right Live panes, select the Send to Live icon.

3.16.6 Add Scriptures to Service

Adding scriptures to a service can be done by selecting a group of verses or by moving one verse at a time.

To add Bible verses you can click on a verse, hold and drag your selection from the Library over to the Service
Manager or, after selecting the verse or group of verses you want to use, click the Add to Service icon. This will
add your scriptures at the bottom of the Service.

3.16.7 Locking Search Results

Selecting the Lock icon locks and unlocks the search results.

This feature can be used to combine multiple search results into one group of scriptures. To use this feature, do a

search for the first gorup of verses, then select the Lock icon and then search to your second group of verses. The
second group of verses will be added to the first group of verses. You can continue to add more search results or select

the Lock icon again to unlock the results and return the search results to be replaced with each search.
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3.16.8 Quick Search

The quick search tab provides a simple search capability that can search for scripture text or a scripture referance. Use
the dropdown in the Find: data entry box to choose the type of search.

Select your primary Bible by selecting it in the Version dropdown.

Select a second Bible to search using the Second dropdown or leave it blank if you are not using a second Bible.

Select your desired layout style using the Layout style dropdown.

Enter your search text, Pressing the Enter or selecting the Search button activates the search.

When using the scripture referance search, the referance needs to be in one of a few formats. You can see all the
formats available by typing a book name and pressing the Enter.

A common format is “Bookname Chapter:verse - verse” (Gen 1:1-12)
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3.16.9 Advanced Search

The advance search tab provides another search process that can search for scripture text using dropdowns to set the
search criteria.

To start your search, select your primary Bible by selecting it in the Version dropdown.

Select a second Bible to search using the Second dropdown or leave it blank if you are not using a second Bible.

Select your desired layout style using the Layout style dropdown.

Select the book of the Bible to search using the Book dropdown.

Select the starting Chapter of the book using Chapter dropdown to the right of From:

Select the starting Verse of the chapter using the Verse dropdown to the right of From:

Select the ending Chapter of the book using Chapter dropdown to the right of To:

Select the ending Verse of the chapter using the Verse dropdown to the right of To:

Selecting the Search button activates the search.
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3.17 Custom Slides

Adding a new custom slide displays the following dialog:
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Title: Name of your custom slide.

Note: Anything typed in the title name between these brackets <> will not be displayed in the screen title. The option
to show titles can be configured using Custom Display.

Add: After clicking on Add you will enter your text you want to display in this box. To create multiple slides, click
the Split Slide button. When you have finished adding your text, click on the Save button.

Theme: Select the theme you want to use for your Custom slide from this drop down box.

Credits: Anything typed in this box will be displayed in the footer information on the display. When you are finished,
click the Save button.

To Edit your slide, click on Edit to edit part of it or Edit All if you need to make multiple changes. Use the Up and
Down arrows to change the arrangement of your custom slide.
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3.18 Exporting Songs

OpenLP has the ability to export your songs in the OpenLyrics worship song format. This is convenient for transferring
your songs to another computer or for backup purposes.

Song export is accessible through File → Export → Song and once clicked the following dialog box will appear.

Click Next to continue or Cancel if you change your mind.
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You can select the songs you want to export by clicking on each song you want to export.

Search: Searches for a song title or keyword in a title.

Uncheck All: If you are not sure of your selections click Uncheck All and start over.

Check All: Click Check All selects all of the songs for export.

When you are finished with your selection click Next.
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Select Directory: Select the directory where you want the songs to be saved. The list of songs to be exported are
shown below.

Note: Exporting songs will create a file for each song, If you export one hundred songs, you will have have one
hundred individual files.
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Click Finish to complete the export process.

3.19 Song Usage Tracking

OpenLP gives you the ability to track all the songs that are displayed live or printed. Every time a song is displayed
live or printed it will be logged. This is useful for CCLI or any other church copyright license that may require tracking
or for your own personal use to know what songs you previously used.

Song Usage Tracking is listed under the menu item Tools → Song Usage Tracking
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You can start and stop tracking by using your keyboard F4 key, going to Tools → Song Usage Tracking → Toggle
Tracking or by using one of these buttons below Service.

Song usage tracking is active.

Song usage tracking is inactive.

Extract Tracking Data

Now that you have tracked the songs that were displayed or printed you will want to access the information. Go to
Tools → Song Usage Tracking → Extract Tracking Data and you will be presented with dual calendars.
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Select Date Range

The calendars on the left side and right side are what you use to select the beginning and end dates of your tracking
information. Select the date you want to begin your tracking information on the left and end your tracking information
on the right. Use the left and right arrows or click on the month or year and then select the day.

Report Location

Use this button to choose the folder you want to save your tracking file in. Click OK and click OK again or Cancel
at any time. This saves your tracking log as “usage_detail_<start date>_<end date>.txt”. You can open this file in any
text viewer or your spread sheet application.

The usage detailed report will be in the following format: Year, Month, Day, Hour, Minute, Seconds, Micro-seconds,
Song title, Copyright, CCLI number, Author, Song (meaning a song was tracked), and if your song was Displayed or
Printed.

Delete Extracted Data

When you do not need your previously saved data past a certain point in time, you can delete it. Go to Tools → Song
Usage Tracking → Delete Tracking Data
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You will be presented with a single calendar. Select a date by using the left and right arrows or click on the month or
year and then select the day. All tracking information prior to the date you selected will be deleted. Click OK to delete
or Cancel if you change your mind.

Tip

Every time you display or print a song, whether for practice or during a service, it will be logged if tracking is on.
This could create a lot of duplicate songs being logged. Toggle the tracking on and off, as needed, at the bottom right
under Themes using these buttons.

Song usage tracking is active.

Song usage tracking is inactive.
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3.20 Alert

From time to time it may be necessary to display a small unobtrusive message to the congregation. In OpenLP this
is known as an Alert. Examples could be a car with the headlights left on, a parent needed in nursery, or anything
else somebody may need notified about. This is easily accomplished using the Alert, which is accessible from the top
Menu under Tools → Alert.

Alert text: Enter the message you want displayed in this box.

Parameter: This box is used for words you want to insert into the alert text.

You will add the Parameter text into the alert text using “<>” (without quotations). Anywhere in the Alert text that
you add these two symbols, <> side by side, will insert any text you have in the parameter box into the Alert message.

3.20.1 Example of Use

Alert text: The owner of the vehicle with license plate number <> your lights are on.

Parameter: HNN432

These two settings will display like this:

The owner of the vehicle with the license plate number HNN432 your lights are on.

If you use the same alerts on a regular basis, Save your Alert and you will have access to the alert with a click of the
mouse. You may also click on New to make a new alert or Delete an alert you do not need.
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When you are ready to Display your Alert you have two options. Clicking on Display will display the Alert and the
Alert Message window will remain open. Clicking Display & Close will display the alert and close the Alert Message
window.

All details of the display, font, color, size and position are adjusted from the top Menu item Settings → Configure
OpenLP, Alert tab and the instructions here. Configuring OpenLP

Please note: Alert Message is a Plugin that needs to be Active in the Plugin List for use.

3.21 The Web Remote

OpenLP gives you the ability to control the Service. You also have the ability to search for and add or display media
from the Library or send an Alert, using a remote computer, netbook or smartphone and a web browser. You can use
the web remote to control the entire service away from the main computer or, have the nursery or daycare send an
Alert message to the projection screen. This could also be used for a guest speaker or worship team leader to control
their own slides if needed.

The Web Remote was moved to being part of the core program in version 2.9.2. The only thing you need to do is go
into Configuring OpenLP, select the Remote Interface item in the menu on the left side of the Settings window then
press the Check for Updates button. If the Current version number is not the same as Latest Version then press the
Upgrade button. When the numbers match, press the OK button at the bottom of the settings window.

Versions before 2.9.2 The first step is to make sure the Remote plugin is activated. You can accomplish this by
following the instructions in the Plugin List. The second step is to configure the settings you will use with the web
browser. You can find these instructions and settings in Remote Interface.

Open a web browser, type in the Remote URL you found in Remote Interface and press the Enter key. For this
example we will use http://192.168.1.112:4316. You will then be presented with the home page of the OpenLP
Remote. The picture shows a service with nothing in it.
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3.21.1 Service Manager

The web remote opens to the Service page and if a service is loaded, it will display the service item list from the
Service.

Clicking on any item in the Service Manager will immediately take you to the Slide Controller.

You will find the following buttons throughout the web remote interface.

The Menu button is found on most of the pages in the top left hand corner of the remote interface
and clicking it will display a menu of the web remote pages and a helpful setting.

Selecting any of the top five menu items will change the web remote page to the page responsible for that
area of the web remote.

Selecting any of the three views will change the web remote page to the default view selected.

Enabling the Fast Switch setting will display a set of Icons at the bottom of the page to switch between
pages without using the menu.
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This button will move upward through the Service items to the previous items.

This button will move downward through the Service items to the next item.

This button will move upward through the Slide Controller. If the settings Slide Controller have been
enabled this button will move from the first slide of a service item to the last slide of the prevoius service
item.

This button will move you downward through the Slide Controller. If the settings Slide Controller
have been endables this button will move freom the last slide of a service item to the next first slide of the
next service item.

This button will blank the display on the projector screen. If the settings Slide Controller have been
enabled clicking on an item in the Service Manager will automatically show the item on the screen.

This button will blank the display on the projector screen to the current theme. Note that this is not
available for item which does not use themes, such as images, presentations and media. If the settings
Slide Controller have been enabled clicking on an item in the Service Manager will automatically show
the item on the screen.

This button will hide the display on the projector screen and therefore show the desktop. If the settings
Slide Controller have been enabled clicking on an item in the Service Manager will automatically show
the item on the screen.

If the screen is blanked, clicking on this button will unblank the display.

This button will display the Service page of the web remote.

This button will display the Slides page of the web remote.

This button will display the Alerts page of the web remote.

This button will display the Search page of the web remote.

This button will display the Themes page of the web remote.

238 Chapter 3. Reference Manual



OpenLP Reference Manual, Release 3.0

3.21.2 Slide Controller

After you click on an item in the Service Manager you will be taken to the Slide Controller interface.

You will find the verses displayed as they appear in the live view on the main computer and the first verse will be

displayed on the projection screen. You can use the , or click on each verse using the mouse to display them.

Note: The remote interface replicates the OpenLP software. When displaying images, clicking on a single image in the
service manager will display it immediately. The first image in a group of images and the first slide in a presentation
will also be displayed immediately when clicked on in the web remote service manager.

3.21.3 Alerts

You can send an alert to the projection screen by entering the text on the line and clicking on Send. The alert will be
displayed as you have it configured in Alerts.
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3.21.4 Search

Using the search function gives you the ability to search for a particular media, add it to the service or display it
immediately.

Clicking on Songs will display your media options to search through. Click on the media type that you want to search.

Enter the text you want to search for. You can click Search or press Enter on the keyboard. If you do not enter any
text to search for, you will be presented with your entire list of media for the selected media.

Note: When searching Bibles media you must enter the exact name, chapter, verse or verses. Searching Songs will
search titles and lyrics with the text used.

For this example we are searching “Songs” and the word “God”. The results will be displayed below the search button.
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After finding the song you searched for, click on Send Live to immediately display your media on the Live screen.
Click on Add to Service to add your media to the bottom of the Service.

3.21.5 Theme Manager

The Theme page lets you select a Global or Service level theme. When the theme changes is dependent on the theme
settings under Themes. To make the change take effect on the current Service Item you will need to resend the Service
Item to the Live screen.

Clicking on any item in the Theme Manager will select the theme.

You can select the Theme Level, if you want to see the theme names and how many columns you want to view on the
page.
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3.22 The Stage View

Stage view gives you the ability to set up a remote computer, netbook or smartphone to view the live service being
displayed on the projection screen in an easy to read font on a black background. This is a text only viewer, though it
will show thumbnails of images and presentations.

You can configure the settings you use with the web browser. You can find these instructions and settings in Remote
Interface.

Open a web browser, type in the Stage View URL you found in Remote Interface and press the Enter key. For this
example we will use http://192.168.1.112:4316/stage. You will then be presented with the home page of the OpenLP
Stage View. On most browsers you can press F11 to go into fullscreen mode.

At the top right hand side you will see the time of day. This can be changed from 12 hour to 24 hour format in Remote
Interface. If you added a note to the the song it will be the next line below the time. See Adding a Service Note
for adding notes. On the same line as the clock will be the Bible or song verse numbers and one of those will be
highlighted. The lyrics or verses highlighted below the verse numbers correspond to the highlighted verse number. In
this example V1 is highlighted and the corresponding first verse below it is highlighted.

At the bottom right had side you will see a Close button. Clicking on the button will close the stage page and open the
Web-Remote main page.

If there is an image, presentation or media being displayed you will see the title of the displayed item. Below the title
will show the next item to be displayed in the Service.
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3.22.1 Custom Stage Views

It is possible to create custom stage view with custom styles, javescript and html. To create a custom stage view, go to
the OpenLP Data Folder by going to Tools → Open Data Folder. Inside the data folder create a folder names stages.
Inside the stages folder you can now create a folder which will be the name of your custom view, an example could
be myview. Now copy stage.html, stage.css and stages.js from Custom Stage View Zip and customize
them to your needs.

To access the custom stage view in a browser go to http://myopenlpip:4316/stage/myview.

3.23 The Main View

Main view gives you the ability to set up remote computers that will mirror what your projector is showing. The Main
view basically works by taking screenshots of what the projector is showing and then presenting it in a browser. This
means that audio and video playback will not be presented in the Main View.

You can configure the settings you use with the web browser. You can find these instructions and settings in Remote
Interface.
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Open a web browser, type in the Main View URL you found in Remote Interface and press the Enter key. For this
example we will use http://192.168.1.112:4316/main. You will then be presented with the home page of the OpenLP
Live View. On most web browsers you can press F11 to go into fullscreen mode.

3.24 The Chord View

The Chord view is stage view that displays chords if they are in the songs. You can configure the settings you use with
the web browser. You can find these instructions and settings in Remote Interface.

The chords view adds another control for translation of the cords. clicking on this control will translate the chords up
or down an octive.

Open a web browser, type in the Stage View URL you found in Remote Interface and press the Enter key. For this
example we will use http://192.168.1.112:4316/chords. You will then be presented with the home page of the OpenLP
Stage View. On most browsers you can press F11 to go into fullscreen mode.
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3.25 iOS Remote

OpenLP gives you the ability to control your service from an iOS-based device. The following tutorial will describe
how to install and use the application.

3.25.1 Installation

Open the Apple App Store and search for OpenLP. You should find the OpenLP Remote app. Install this app.

When you start the app, you will initially see the launch screen, followed by the service screen once the app has loaded.
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3.25.2 Settings

After the installation is complete and you open the OpenLP Remote app you will need to configure your settings.
Open the settings by touching the settings icon in the top left corner.

Server Details

You will need to configure the server settings you will use with your device. You can find these instructions and
settings in the OpenLP desktop application under Remote Interface.

Note: To use the OpenLP Remote you will need to be on the same network as the main computer.

Server IP: Enter the Server on IP address found in Remote Interface.

Server port: Enter the Port number found in Remote Interface and enter it in the box. By default this is 4316.

Authentication

Needs auth: Tap this switch to enable authentication. Authentication needs to be set up in User Authentication.

User ID: Here you can enter a username used for accessing OpenLP remotely. This must be the same as set in User
Authentication.

Password: Here you can enter a password used for accessing OpenLP remotely. This must be the same as set in User
Authentication.

Scrolling

Use precise slide scrolling: By default, iOS’s scrolling effects can make scrolling up and down the slides difficult.
When tapping this switch you can turn iOS’s scrolling effects on and off, which may result in more precise
scrolling.
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3.25.3 Using the iOS Remote

After you have completed the setup you are now ready to use the app. At the bottom of the app you can see the Service,
Slides, Alert and Search tabs.

Service

Selecting Service will take you to the Service tab. Selecting an item with a in the service manager will immediately
take it live on the projection screen and you will be taken to the Slides screen on your device. You can use the arrows
buttons shown on the bottom left and right to move to the next slide inside the item.

Along the bottom of the Service tab you can see buttons that say, Blank, Theme, Desktop and Show. These buttons
will blank the display, set it to the current theme, show the main computer’s desktop, or show the currently live item,
respectively.

Slides

Selecting Slides will take you to the Slides tab. This displays what ever is live at the moment. You can use the arrow
buttons shown on the top right to move to the next slide inside the item.
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Along the bottom of the Slides tab you can also see the Blank, Theme, Desktop and Show buttons.

Alerts

To send an alert to the display, touch the Alerts tab at the bottom of the screen. Type in your alert text in the text
box and press the show button at the bottom to show your alert in OpenLP. The alert will be displayed as you have it
configured in Alerts.
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Search

If you want to search for an item that is not currently in your service, press on the Search tab at the bottom of the
screen. Type your search term in the search box at the top of the screen, and then select which type of item you want
to search for.

Once OpenLP has finished searching for you, the results of your search will be visible in the search screen. Touch a
search result to add it to your service.
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3.26 Glossary

The developers of OpenLP have strived to make it a straightforward and easy to use application. However, it is good
to be familiar with a few terms that will be used throughout this documentation, and when seeking support.

3.26.1 First Time Wizard

The First Time Wizard gives you the ability to perform a basic setup of OpenLP. It runs automatically before OpenLP
starts for the first time. The First Time Wizard can be run again if needed.

3.26.2 Formatting Tags

Formatting Tags give you the ability to add additional text formatting to text in songs and custom slides.

3.26.3 Main Window

The Main Window is what you will see when you first open OpenLP. It contains all the tools and plugins that make
OpenLP function.
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3.26.4 Library

The Library contains a number of tabs which the plugins supply to OpenLP. Each tab in the Library is called a Library
Item. You can send songs, Bibles, etc from the Library Item to the Preview Slide Controller or Live Slide Controller.
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3.26.5 Library Item

A library item is a tab in the Library. The library item contains any items from the various plugins which can be
displayed on the display screen.

3.26.6 Platform

When the word “platform” is used, it is usually referring to your operating system, such as Windows, Linux, or macOS,
in combination with the CPU family.

3.26.7 Preview Pane

The preview pane is a section to preview your library items before you go live with them.
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3.26.8 Service File

A service file is the file that is created when you save your service in OpenLP. The service file consist of Service Items

3.26.9 Service Items

Service items are the Library Item that are in the Service Manager.

3.26.10 Service Manager

The service manager contains the library items in your service file. This is the area where your library items go live.
You can also save, open, and edit services files from here.
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3.26.11 Slide Controller

The Slide Controller controls which slide from a Service Items is currently being displayed, and moving between the
various slides.
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3.26.12 Preview Slide Controller

The preview Slide Controller shows you a simple preview of your item. It does not send any output to the display
screen.

3.26.13 Live Slide Controller

The live Slide Controller controls the live output to the display screen.

3.26.14 Theme Manager

The theme manager is where themes are created and edited. Themes are the text styles and backgrounds that you use
to personalize your services.

3.26.15 Projector Manager

The Projector Manager is where you can manage and control projectors.
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CHAPTER

FOUR

QUESTIONS AND TROUBLESHOOTING

4.1 Frequently Asked Questions

4.1.1 General Questions

Can I help with OpenLP?

OpenLP is possible because of the commitment of individuals. If you would like to help there are several things that
you can get involved with. Please see our Contribute page for more information.

I use and like OpenLP and would like to tell others online. Where can I do this?

A variety of places!

• Are you on Facebook? Then become a fan.

• Are you on Twitter? Then follow OpenLP, and retweet the announcements.

• If you have a website or blog, then link to our web site with a few words saying what OpenLP is and why you
like it.

• Add a placemark on our Worldwide Usage map, so others in your locality can see someone close by is using it.

• If you are a member of any Christian forums or websites, and their rules allow it, then perhaps review OpenLP
or ask others to review it.

What operating systems does OpenLP support?

OpenLP is designed to be cross platform. Currently it has been known to run on Windows (Vista, 7, 8, 10), Linux
(Ubuntu and its variants, Fedora, Debian, ArchLinux, Mint, OpenSUSE and many others), and macOS. Please let us
know if you have successfully run it on something else.
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Which programming language is OpenLP developed in?

OpenLP is written in Python 3 and uses the Qt5 toolkit via the PyQt5 library. Both are cross-platform which allows
the software to run on different types of machine and so allow more people access to free worship software. Python is
one of the easier programming languages to learn, so this helps us develop and find bugs faster, and also allows more
developers to contribute with the project.

Which written languages does OpenLP support?

OpenLP has support for multiple languages which can be seen on the Settings →Translate menu. However some
of these translations are incomplete. If you would like to help complete or start to translate OpenLP into your own
language then see the Getting started page for translations.

4.1.2 Upgrading

Warning: Newer versions of OpenLP are not backwards compatible with earlier versions. Once you have
upgraded to a newer version, the older version of OpenLP will not be able to read the upgraded files.

Note: It is always a good idea to make a backup when prompted by OpenLP.

Can I upgrade from any 1.9.x or 2.0.x release to 3.0?

No, you should first upgrade to the last stable release in the 2.0-series (2.0.5) and then upgrade to 3.0 to ensure that
data is correctly converted. You can download OpenLP 2.0.5 from https://get.openlp.org/2.0.5/.

Can I upgrade directly from 1.2 to 3.0?

No, you will have to install 2.0.5 first, then import the 1.2 data and then upgrade to 3.0. See the 2.0 documentation for
how to upgrade from 1.2 to 2.0. You can download OpenLP 2.0.5 from https://get.openlp.org/2.0.5/.

Does 3.0 replace older 2.x versions, or can they be run side by side?

OpenLP 3.0 and earlier 2.x versions cannot run side by side. When running 3.0 for first time any existing 2.x data will
automatically be converted to the 3.0 format. OpenLP 3.0 will ask if it should make a backup on startup, which can be
used in case you want to downgrade again.

OpenLP 3.0 cannot read service files created by OpenLP 2.0.4 and earlier, it can only read service files created by
OpenLP 2.0.5 and higher.
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Where can I download an older version of OpenLP?

Warning: Only the most current version of OpenLP is supported. If you submit a bug report for an older version,
you will be told to upgrade first.

Sometimes you might need to download an older version of OpenLP. You can always find previous versions of OpenLP
on our download server: https://get.openlp.org/

4.1.3 Using OpenLP

I have started OpenLP, but I cannot see the songs or bibles section in the Library

When you installed OpenLP, the first time wizard would have asked which plugins you wanted, and songs and bibles
should have been selected. If for some reason they were not, then you will need to activate them yourself. See below
for instructions.

How do I activate / deactivate a plugin?

Plugins can be turned on and off from the Plugin List Screen. Select the plugin you wish to start/stop and change its
status. You should not need to restart OpenLP.

What are these plugins that I keep seeing mentioned?

The plugins allow OpenLP to be extend easily. A number have been written (Songs, Bibles, Presentations) etc but it is
possible for the application to be extended with functionality only you require. If this is the case then go for it but let
us know as we can help and it may be something someone else wants.

How do I enable PowerPoint/Impress/PowerPoint Viewer?

Note: PowerPoint, Keynote and LibreOffice are not supported on macOS due to limitations with the platform. This
is outside of our control.

Note: PowerPoint Viewer 2010 is not supported, use 2003 or 2007.

First of all ensure that the presentation plugin is enabled (see above). Then to enable a presentation application, go to
the Settings dialog, switch to the Presentations tab and check one of the enabled checkboxes. OpenLP will automat-
ically detect which of the three you have installed, and enable the appropriate checkbox(es). Check the applications
you require, and then restart OpenLP for the change to be detected.
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I am on Windows and PowerPoint is installed, but it does not appear as an option

Try installing the Visual C++ Runtime Redistributable.

Why don’t PowerPoint presentations advance automatically?

The reason that PowerPoint does not advance automatically is that it can only do so when it has the focus. But
when using OpenLP for controlling presentation, OpenLP has the focus. So in order to make PowerPoint advance
automatically the focus must be switched to PowerPoint, which can be done by clicking the Powerpoint-icon in the
taskbar once the PowerPoint presentation has opened.

Is it possible to get a particular translation of the Bible? How?

Note: OpenLP does not have distrubution rights for most popular translations of the Bible. Bible societies require
exhorbitant licensing costs which OpenLP could never afford. We cannot help you find those Bibles.

The Bible plugin has a Import Wizard which can import Bibles from a variety of sources. The following sources are
supported:

CSV The format is documented in the OpenLP API documentation.

OSIS An XML format for Bible. You can export Bibles from the Sword Project into OSIS using the mod2osis
tool. After using the Sword software Media Manager (or other Sword frontend, like BibleTime or Xiphos)
to download the required Bible, run the following command from the command line (works on Windows and
Linux):

mod2osis NAME > NAME.osis

The NAME parameter is the name of your Bible, as you see it in Sword. Note that the NAME is case sensitive on all
environments. Once you have exported your Bible to OSIS, the Bible import wizard will the read NAME.osis
file and import your Bible.

OpenSong OpenSong has a good selection of Bibles on their download page.

Web Download OpenLP can download Bibles on demand from the following 3 sites:

• Crosswalk

• BibleGateway

• BibleServer

Zefania The Zefania project has many bibles available from their website.

Why do my Bible verses take a long time to load?

In order to better conform to copyright law, the Web Download Bibles are not downloaded when you import them, but
on the fly as you search for them. As a result, the search takes a little longer if you need to download those particular
verses. Having said that, the Web Download Bibles cache downloaded verses so that you do not need to download
them again.
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My Bible is on the Web Download sites, but my Church is not on the internet. What options do I
have?

When you create and save a service, all the items in the service are saved with it. That means any images, presentations,
songs and media items are saved. This is also true for bibles. What this means is you can create the service on your
home computer, insert a Bible passage from the web, save it and then open the service using your church computer
and voila, the Bible passage should be there! Note this can also be done with songs, etc!

4.1.4 Location of OpenLP files

Where do I find the configuration file?

Linux and Unix-like systems

If your distribution supports the XDG standard, you will find OpenLP’s configuration file in:

/home/<user>/.config/OpenLP/OpenLP.conf

If that file and/or directory does not exist, look for:

/home/<user>/.openlp/openlp.conf

<user> is your username.

macOS

You will find your configuration file here:

/Users/<user>/Library/Preferences/org.openlp.OpenLP.plist

<user> is your username.

Windows

On Windows, OpenLP does not use a configuration file, it uses the Windows registry. You can find the settings here:

HKEY_CURRENT_USER\Software\OpenLP\OpenLP

Where do I find the data folder?

Normally you can open the data folder by using the menu Tools → Open Data Folder and a file manager window will
appear with the data folder. In some cases due to bugs or other issues this is not an option, and the folder must be
found manually.
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Linux and Unix-like systems

The data folder is located in /home/<user>/.local/share/openlp.

macOS

On macOS the data folder is located in /Users/<username>/Library/Application Support/openlp

Windows

To get to the data folder on Windows, pres the Windows Key and “R” at the same time. This will open a the Run
dialog. Enter %appdata%\OpenLP and press <Enter>. This will open a file manager within the data folder.

4.1.5 Features

Why has popular feature request X not been implemented?

There are only a handful of developers working in their spare time. If we were to try and include everything we wanted
to implement, then we would never be able to release any new versions of OpenLP.

I have a great idea for a new feature, where should I suggest it?

First of all check it is not listed as a “wishlist” bug on Launchpad. If it is, then you need to say no more, it has already
been suggested! If it is not on the list, then head to the forums and post the idea there.

4.2 Troubleshooting

4.2.1 Something has gone wrong, what should I do to help get it fixed?

If you have found an error in the program (what we call a bug) you should report this to us so that OpenLP can be
improved. Before reporting any bugs please first make sure that there is not already a bug report about your problem:

1. Check the OpenLP Issue list

2. Check the Troubleshooting forum

If there is already a bug report, you may be able to help by providing further information. However, if no one else
has reported it yet, then please post a new bug report.

1. The preferred place for reporting bugs is the bugs list on GitLab.

2. Alternatively, if you do not have a GitLab account and do not want to sign up for one, you can post in the
Troubleshooting forum.
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4.2.2 What information should I include in a bug report?

Since OpenLP 1.9.4, there is a bug report dialog which automatically opens when OpenLP hits a serious bug. However,
this does not appear all the time, and in some behavioural bugs, you will have to file a bug report yourself. The
following items are information the developers need in order to reproduce the bug.

Operating System Include information such as the version of your operating system, the distribution (e.g. Ubuntu,
Fedora, etc.) if you are using Linux, or the edition (e.g. Home, Basic, Business, etc.) if you are using Windows.

Version of OpenLP You can find out the version of OpenLP by going to Help → About

Steps to Reproduce The exact steps the developers need to follow in order to reproduce the bug.

Version of MS Office or LibreOffice If you are using the song imports or the presentation plugin, you will need to
supply the version of Office or LibreOffice.

Bible Translation and Source If the bug occurred while you were working with Bibles, specify the translation of the
Bible, and the source format if you imported it yourself.

Any Other Information Often bugs are caused by something that might not seem to be directly related to the bug
itself. If you have any other information with regards to actions you performed or other activities when the bug
occurred, it would be welcomed by the developers.

The more information you give us, the better we can help you.

4.2.3 I have been asked to email a debug log, where do I find this?

We may need a debug log to help pin-point the issue. A new log file is created each time you start OpenLP so copy the
file before you run the software a second time. On Windows a Debug option is available in the start menu. On other
systems, you will need to run OpenLP from the command line, with the following option: `-l debug`. Please note,
that is a lowercase L.

If you have not been given a specific email address to send it to, then please do not paste the log contents straight into
a forum post. Instead, open the log file in a text editor (such as notepad on Windows) and copy and paste the contents
into somewhere like pastebin.com. Then give us the link to the page that is created.

Windows

Find the OpenLP 3.0 folder in your Start menu. Choose the “OpenLP (Debug)” option. OpenLP will start up in Debug
mode and save the log file.

To get to the log file folder on Windows, press the Windows Key and “R” at the same time. This will open the Run
dialog. Type %appdata%\OpenLP and press <Enter>. This will open a file Explorer window within the OpenLP
folder. Keep this Explorer window open.

Now repeat the steps you need to take in OpenLP to reproduce the problem you had, and then close down OpenLP.

In the Explorer window you left open, you will see the openlp.log file. This is the file to e-mail.
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Linux and Unix-like systems

If you installed OpenLP from a package:

@:~$ openlp -l debug

Alternately, if you are running OpenLP from source:

@:~$ ./openlp.pyw -l debug

If your Linux distribution supports the XDG standard, you will find the log in:

~/.cache/openlp/openlp.log

Otherwise, you will find the log file in:

~/.openlp/openlp.log

Mac OS X

Open Terminal.app and navigate to where you installed OpenLP, usually /Applications:

@:~$ cd /Applications

Then go into the OpenLP.app directory, down to the OpenLP executable:

@:~$ cd OpenLP.app/Contents/MacOS

And then run OpenLP in debug mode:

@:~$ ./openlp -l debug

Once you have done that, you need to get the log file. In your home directory, open the Library directory, and the
Application Support directory within that. Then open the openlp directory, and you should find the openlp.log file in
that directory:

/Users/<username>/Library/Application Support/openlp/openlp.log

<username> is your username.

4.2.4 I can not play videos or other library items.

If you can not play video or audio through OpenLP, the problem is most likely that the players have not be properly
configured. The recommended player for OpenLP is VLC, see the manual for Media for how to setup VLC as your
default player.

If you want to use the System player, but it cannot play your audio or video files, you can look below for how best to
set it up.
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Codecs

You may need to install codecs for certain files to play. Most newer versions of Windows and OS X will support most
media types. Most Linux distributions will require a little more help to get certain media types to play.

Microsoft Windows

Later versions of Microsoft Windows (Vista, Windows 7) generally come with everything you need to play most media
formats. If for some reason you need additional codecs we have seen success from the Combined Community Codec
Pack (CCCP). You might also wish to check out the K-Lite Codec Pack. If you are having issues, results do seem to
vary with the different options. What works for some may not for others, so some trial and error may be required.

macOS

Most modern Macs should already support most popular formats out of the box.

Ubuntu Linux (and variants)

If you are using Ubuntu Linux, or one of its variants (Kubuntu, Edubuntu, etc. . . ) it is a fairly quick and easy process
to get all the codecs you need to make things work. You will need to install two meta-packages that contain all
the multimedia codecs that you will generally need. From the Software Center install ubuntu-restricted-extras and
Kubuntu-restricted-extras, or from the terminal:

user@linux:~ $ sudo apt-get install ubuntu-restricted-extras kubuntu-restricted-extras

Note if you are running Kubuntu there is no need to install the ubuntu-restricted-extras meta-package

For more information on Ubuntu and multimedia issues please check out the community documentation.

Arch Linux

The following command provides the most complete solution for codecs on Arch Linux:

root@linux:~ # pacman -S gstreamer0.10-{base,good,bad,ugly}-plugins gstreamer0.10-
→˓ffmpeg

If you need more help with Arch Linux and multimedia please see the Arch Linux documentation.

Debian Linux

You will need to add the Debian Multimedia Repository. So add the folowing to /etc/apt/sources.list:

deb http://www.debian-multimedia.org testing main non-free

Then update the repository info:

root@linux:~ # apt-get update

Then install the following packages:

root@linux:~ # apt-get install gstreamer0.10-ffmpeg gstreamer0.10-lame gstreamer0.10-
→˓plugins-really-bad gstreamer0.10-plugins-bad gstreamer0.10-plugins-ugly gstreamer0.
→˓10-plugins-good gstreamer0.10-x264
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Fedora Linux

You will need to set up Fedora to play most media formats. This is accomplished using the rpmfusion repository.

Note the following commands will enable a third party repository to your system. Please check out the RPM Fusion
site for more information.

To enable both the free and nonfree components for any Fedora official release enter the following commands:

su -c 'yum localinstall --nogpgcheck http://download1.rpmfusion.org/free/fedora/
→˓rpmfusion-free-release-stable.noarch.rpm http://download1.rpmfusion.org/nonfree/
→˓fedora/rpmfusion-nonfree-release-stable.noarch.rpm'

After enabling the rpmfusion repository you will want to refresh your package list, perform any updates and search
for gstreamer-good, bad, and ugly and install.

Follow the tutorial using the rpmfusion repository to enable extra audio and video formats on Fedora

4.2.5 The Library appears to be missing some features

If you do not see all the features listed in the Library, you may need to enable them.

To enable the plugins navigate to Settings → Plugins or press Alt+F7. You will want to click on the plugin to the left
that you would like to enable and select active from the drop down box to the right.

By default all plugins should be enabled during the first run wizard except the remotes plugin, unless you specify
differently.
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4.2.6 I can not see the book, chapter, and verse when I display scripture

The book, chapter, and verse should be displayed when you display scripture. If you can not see this your theme
probably has the text size too small for the info to be seen. See the section of the manual on Themes if you need more
info on text sizes in themes.

4.2.7 I am using PowerPoint 2010 or PowerPoint Viewer 2010 and presentations do
not work

Currently OpenLP does not support PowerPoint Viewer 2010. PowerPoint 2010 should work correctly, although some
users have reported problems. If you have issues with PowerPoint 2010 or PowerPoint Viewer 2010 try the PowerPoint
2003 or 2007 Viewers. Download the PowerPoint 2007 viewer for free.

4.2.8 I have PowerPoint installed but it does not show as a presentation option

macOS

Due to limitations on macOS, OpenLP cannot currently interface with PowerPoint, LibreOffice or Keynote.

Windows

Installing the Visual C++ Runtime Redistributable has fixed this problem according to some of our users.

4.2.9 I am running a Linux Distro and cannot see the menu icons

This seems to be a problem with XFCE and some versions of Gnome too. To correct this problem, open a terminal
and type in the following commands:

gconftool-2 --type boolean --set /desktop/gnome/interface/buttons_have_icons true

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons true

4.2.10 I chose to use a web Bible but it did not download the entire Bible

Due to copyright restrictions OpenLP cannot download an entire Bible. It can only download the section you search
for. If you do not have an internet connection where you intend to use OpenLP you will need another scripture source.
For more information about acquiring Bibles please see the section on the Bible Import Wizard.

4.2.11 OpenLP is using a large amount of RAM when showing a presentation

OpenLP uses a large amount of RAM when showing a presentation due to the way it handles presentations. OpenLP
itself is unable to show those presentations or load the presentation files, so it interacts with the presentation through
either Microsoft PowerPoint or LibreOffice Impress. In order to show the slides in the slide controller, OpenLP
requests that the presentation application export the slides to images, and then uses those images as slides. This results
in a large amount of RAM being used, especially in presentations with more than about 20 slides.
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4.2.12 OpenLP is not displaying correctly, or is not on the correct screen

Please read the documentation on Dual Monitor Setup. It is very important to have dual monitors setup properly for
OpenLP to function as expected.

4.2.13 Previews are slow to load when using a theme with an image background

If you are using a JPG formatted image for your background try converting it to another format. There is a notable
performance difference between JPG and a format such as PNG. Other formats work in OpenLP but PNG is the
preferred image format and yields the best performance. Images should also be sized to the size of your output. For
example, if your output screen is 1024x768 you should size your background image to 1024x768 also. OpenLP does
not scale images.

4.2.14 OpenLP crashes on startup on Windows

If Windows is missing a proper driver for the graphics card on the computer, it might cause OpenLP to crash on startup,
resulting in a message saying OpenLP has stopped working. To fix this find, download and install the newest driver
for your graphics card.

4.2.15 I saved service-files in the servicemanager folder but now they are gone

The servicemanager folder which can be found in OpenLP’s data folder is used internally by OpenLP for temporary
files and anything in there can and will be deleted by OpenLP. In general you should not modify or create files in
OpenLP’s data folder unless you know what you are doing.

4.2.16 OpenLP freezes on Xfce4 in a dual monitor setup

There is an issue with the Xfce4 compositor that makes OpenLP freeze when using a dual monitor setup. See config-
uration of dual monitor for Xfce4 for a solution.

4.2.17 MP3’s and other audio formats do not work

This is a known issue on some systems, and we have no solution at the moment.

4.2.18 Videos can be slow or pixelated. Background Videos are very slow

If you are just playing videos from the Media plugin, try selecting the Use System for Video playback option in the
Media configuration, accessible by going to Settings → Configure OpenLP → Media. As for text over video, we have
no solution for speeding this up. Reducing the monitor resolution and avoiding shadows and outline text will help. We
are hoping a future release of the toolkit we are using (QtWebKit) will help improve this, but there is no timeframe at
present.
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4.2.19 Downgrade guide (how to restore a backup)

In some cases new versions of OpenLP can contain bugs that was not discovered during testing, which in some cases
can mean that OpenLP cannot function probably and the only way out is to downgrade to the previous version.

Since the OpenLP 2.2 release, new versions of OpenLP always ask if a backup should be made of the data on the first
run. It is always recommend to create this backup, since OpenLPs data format often changes between versions, which
means that older OpenLP versions cannot read the data created by newer versions. In case of downgrading this backup
can be restored. To perform a downgrade follow these steps:

1. Open OpenLP and in the menu go to Tools → Open Data Folder to open the current data folder in a fileexplorer.
If OpenLP cannot open due to a bug see Where do I find the data folder?.

2. Keep the fileexplorer window open and close OpenLP

3. Uninstall OpenLP and install the old version (if you have not done this already). Do not run OpenLP when the
installation completes. Older versions can be downloaded from <https://get.openlp.org/>. Use caution and only
download versions with an even minor number. Odd numbered versions are test versions and may not be stable.
Versions of OpenLP are listed in the format: Major Revision(dot)Minor Revision(dot)Iteration. As an example,
version 2.4.x is a stable version and version 2.3.x is a test version.

4. In the fileexplorer go up one folder-level. You should now see a lot of folders, find the folders that starts
with openlp. Depending on how many upgrades you have done you will see some folders looking like
openlp-20160128-185424. These folders are the backups made by OpenLP on upgrade. The numbers
are a timestamp that you can use to find the backup with the you wish to restore.

5. Rename the openlp folder to openlp-broken-update or similar.

6. Rename the backup folder you wish to restore to openlp.

7. Start OpenLP and watch it load your restored data.

Note: This does not restore your settings!
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